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Introduction

1.1 KnowledgeWorks

KnowledgeWorksD isa LispWorksD toolkit for building knowledge based
systems. It is a multi-paradigm programming environment which allows
developers to express problems in terms of objects, rules, and procedures. The
following sections provide an historical perspective and an overview of the
system.

1.2 Background

Broadly speaking, there have been two generations of commercial knowledge
based system (KBS) shells. The first generation of KBS shells were built on top
of symbolic programming languages such as Lisp. These shells exhibited a
high degree of flexibility and functionality as a result, but suffered because of
their lack of standardization, poor performance, and inability to communicate
with other applications. The second generation of KBS shells were generally
written in C to attack the latter two weaknesses of Lisp-based shells. However
these C-based shells are inevitably less flexible, and exacerbate the standard-
ization issue. Although written in a C (a standard language), each C-based
shell must re-invent a range of features already provided as standard in every
Common Lisp implementation, including the object-system and even elemen-
tary structures like lists.
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KnowledgeWorks addresses all of these issues by providing a high perfor-
mance rule-based system for LispWorks. The latter is a full and efficient
Common Lisp implementation including the Common Lisp Object System
(CLOS), and foreign function interfaces to languages such as C, C++, and
FORTRAN. Hence KnowledgeWorks constitutes a tightly integrated multi-
paradigm programming environment, allowing all the most powerful features
of rule-based, object-oriented and procedural approaches to be combined
without abandoning accepted standards.

1.3 Technical Overview
KnowledgeWorks includes:

= High performance inferencing mechanisms:
forward chaining (OPS compatible)
backward chaining (Prolog compatible)

= A powerful standard object system (CLOS)
= A flexible standard procedural language (Common Lisp)

= Metaprotocols for extending the object and rule systems (MOP & MRP
— see below)

= Support for multiple independent inferencing operations using infer-
encing state objects.

= A full set of graphical tools for developing and debugging knowledge
bases

e Built using the CAPI and integrated with the Common LispWorks IDE.

= Integration within larger applications, possibly following a completely
different paradigm



1.3 Technical Overview
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KnowledgeWorks rules perform pattern-matching directly over the object base
(KnowledgeWorks CLOS objects and KnowledgeWorks structures). Forward
chaining rules use this pattern-matching to perform actions, while backward
chaining rules use it to deduce goals. The actions of forward chaining rules
can call backward chaining rules, and the backward chaining inference engine
may also invoke the forward chainer. Forward chaining rules may be grouped
to increase the modularity of the rulebase and to introduce a mechanism for
procedural control by explicit invocation of rule groups.



1

Introduction

KnowledgeWorks CLOS obijects are conventional CLOS objects with the
simple addition of a mixin class providing KnowledgeWorks functionality,
and they can be used outside the rulebase as ordinary CLOS objects. Any
existing CLOS code may simply be reused and augmented with rules by
adding the mixin to chosen classes.

LispWorks CLOS includes an implementation of the Meta Object Protocol
(MOP) which allows the object system to be extended and customized in a
standard way. In the same spirit of self-reflection, KnowledgeWorks rule-
based system can be extended and customized using a Meta Rule Protocol
(MRP) which allows meta-interpreters to be defined for rules. Together these
protocols mean that KnowledgeWorks defines a region rather than a point in
space of KBS shells, and ensure that developers are not constrained by the
default behavior of the system.

KnowledgeWorks has a comprehensive programming environment that
enables rapid development and debugging of rulebases. Tools are provided
that enable the interactive examination of classes and objects. Graphical
debugging windows allow forward and backward chaining rules to be single-
stepped and monitored. The full LispWorks programming environment and
tools are also available, for example, the editor which allows rules to be
defined and redefined incrementally and dynamically (see the Editor User
Guide).

1.4 Notation Conventions

Syntax will be presented in BNF. Any other non-standard notation will be
explained as used.

= introduces a definition

<..> token, or non-terminal symbol

[..] delimits optional items

* 0 or more repetitions of the previous token
+ 1 or more repetitions of the previous token

separates alternatives
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Tutorial

The tutorial is a simple example based on an animal guessing game. In this
game the user thinks of an animal and the program asks yes/no questions.
Eventually the program mentions an explicit animal and asks whether it is
correct. If so, the game ends. If it is not correct it will ask what the animal was
and ask for a question to distinguish it from its last guess. This is a trivial
example of a learning program. The tutorial assumes a certain familiarity with
Lisp, LispWorks and the Common Lisp Object System (CLOS).

All examples in this chapter assume that you are typing in expressions in a
package that uses the Kwpackage, for instance, KW USER.

2.1 Getting Started

To run the tutorial, put this form in your LispWorks initialization file (usually
called . I'i spwor ks):

(require "kw")
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Start LispWorks. The LispWorks menu bar and the LispWorks toolbar will appear.
Note the position of the KnowledgeWorks menu, which you will use to access the
tools described in this manual.

Figure 2.1 KnowledgeWorks menu
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2.2 Loading the Tutorial

2.2 Loading the Tutorial

Figure 2.2 KnowledgeWorks Listener
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First bring up a KnowledgeWorks Listener by choosing window > Knowledge-
Works > Listener from the LispWorks menu bar. The KnowledgeWorks Lis-
tener accepts Lisp input as well as KnowledgeWorks input. Enter

(i n-package "KW USER")

into the KnowledgeWorks Listener, and then change the current directory to
that of the animals demo by entering

(cd (system|lispworks-dir "exanples/kw animal/"))
If this fails, check the value of the Lisp variable *I i spwor ks- di r ect or y*.
Load the tutorial by typing

(1 oad "defsystent)
to load the tutorial system definition, and

(conpil e-system "ANI MAL" :load t)

to compile and load the rules and object base (CLOS objects). In interpreting
these two commands, the KnowledgeWorks Listener has behaved just like a
Lisp Listener. In general, whenever input has no specific KnowledgeWorks
interpretation, the KnowledgeWorks Listener just accepts it as Lisp.
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2.3 Running the Tutorial

First run the tutorial example a few times. Think of an animal and type

(i nfer) intothe listener. i nf er is a function which starts the forward chaining
engine. Popup question windows will appear, which require clicking on either
Yes or No. If your animal is guessed correctly, execution will terminate and the
listener prompt will reappear. If the final guess is incorrect then:

1. Another popup will ask what the animal was. Type in the name of an
animal and press Ret ur n (or click on OK). If the animal is already known
to the system this constitutes an error. A confirmer popup will inform
you of this; click on Confirm and execution will terminate.

2. You will be asked for a question to distinguish your animal from the sys-
tem’s last guess. Type in a question (again without quotes or double-
guotes) and press Ret ur n. Execution will terminate.

3. The tutorial may be restarted by typing (i nf er) again in the listener.
This time the system will know about your new animal and the question
that distinguishes it. Every time the rule interpreter finishes, it will
return and display in the listener the number of rules the forward chain-
ing engine fired.

2.4 Browsers

There are a number of browsers for examining the state of KnowledgeWorks.
They will be introduced here, and again when the Programming Environment
is discussed in Chapter 5, “The Programming Environment”.
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2.4.1 Rule Browser

Figure 2.3 KnowledgeWorks Rule Browser
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This may be obtained by choosing Window > KnowledgeWorks > Rules. The
defined forward chaining contexts (or rule groups) are displayed in a drop-
down list at the top. There is also a special pseudo-context for all the back-
ward chaining rules, which is shown initially. In this case, the only other con-
text is named DEFAULT- CONTEXT. Below that are listed the rules for the selected
context. Choose DEFAULT- CONTEXT from the drop-down list and click on one of
the rules, for example PLAY, and edit it by choosing Rule > Find Source from the
menu bar. An editor window will appear showing this rule definition.

What this rule says is:

(root ?r node ?node)

(not (current-node ? node ?))

-->

((capi:display-nmessage " AN MAL GUESSI NG GAME - ~
think of an aninmal to continue"))

(assert (current-node ? node ?node))

Browsers
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which means:

If the node ?node is the root node of the tree of questions, and there is no
current node indicating the question about to be asked, then tell the user to
think of an animal and make the root node ?node the current node (so that the
top question of the tree will be asked next). This is the rule that starts the game
by instructing: “if you haven’t got a question you're about to ask, ask the top-
most question in the tree of questions”. The detailed syntax of forward chain-
ing rule definitions will be explained in Chapter 3, “Forward chaining”.

Select"-- Al backward rules --"from the drop-down list and bring up a
backward chaining rule definition by clicking on its name in the Rule Browser
and choosing Rule > Find Source again. The detailed syntax of backward chain-
ing rules is in Chapter 3, “Backward Chaining”.
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2.4.2 Objects Browser

Figure 2.4 KnowledgeWorks Objects Browser
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The Objects Browser is for exploring the contents of the KnowledgeWorks
object base. Start it by choosing Window > KnowledgeWorks > Objects. The
system knows about the CLOS objects that make up the object base. One class
of CLOS objects in this example is the node class so choose NODE from the
Preset query/pattern drop-down. All the node objects in the object base will be
displayed in the pane below. Click on one of these objects and the bottom
pane will display the slots and slot values of the object.

Browsers

1
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To make the display clearer and allow input without explicit package
qualifiers, change the package of the Objects Browser. Do this via Window >
Window Preferences.... Edit the Package pane in the Objects Browser Prefer-
ences dialog so that it says Kw USER and press OK.

Now change the Query field to read (node ?obj ect ani mal ?a) and press
Ret ur n. The animals associated with each node are displayed. In this game
there is a tree of questions with each node object representing a question.
Some nodes have a ni | value for the animal slot; these are the non-terminal
nodes in the question tree. The program learns your new animals by adding
new nodes to the tree.

Now type ?a into the Pattern field (and press Ret ur n). This displays only the
animals. The values displayed in the topmost of the two panes is the Pattern
field instantiated with every possible object that matches the Query field.
However, if the Pattern field is empty then the value of the Query field is taken
to be the pattern.
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Change the Query field to read (and (node ?n ani mal ?a) (test ?a)) and
press Ret ur n.

Figure 2.5 Objects Browser matching animals
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2.4.3 Class Browser

Figure 2.6 KnowledgeWorks Class Browser
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The Class Browser is obtained by choosing Window > KnowledgeWorks >
Classes. This brings up the LispWorks Class Browser with an initial focus on
the class st andar d- kb- obj ect . Select the Subclasses tab to display the sub-
classes of st andar d- kb- obj ect . Double click on NODE in the subclasses pane to
examine the node class used in this tutorial. Select the Slots tab to display its
slots and click on one of the slots in the middle pane, for example the ANl VAL
slot. This displays more information about the slot in the Description pane.

Other useful features of the Class Browser include the Superclasses tab which
display a graph of the superclasses; the Hierarchy tab which displays direct
superclasses and subclasses; and the Functions tab which displays the generic



2.4

functions or methods defined on a class either directly or through inheritance.
For more information about the Class Browser, see the Common LispWorks User

Guide.

2.4.4 Forward Chaining History

Figure 2.7 KnowledgeWorks Forward Chaining History
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This is obtained by choosing Window > KnowledgeWorks > FC History. If you
have just run the tutorial a window will appear of which the left column con-
tains the entry DEFAULT- CONTEXT. These are all the contexts (rule groups) the
forward chaining engine has executed (in this case only one). On the right is a
detailed breakdown of what happened in each cycle within this context. You
will see the rule names listed down the left, and the cycle numbers along the
top. The boxes indicate which rules fired. In the last cycle, you will see a black
box indicating that the rule GAME- FI NI SHED fired, and a outlined box for the
rule PLAY. This means that the rule PLAY could have fired, but that GAVE- FI N-

| SHED was preferred.

Browsers

15
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Look at the definition for GAME- FI NI SHED (find the source using the Rule
Browser) and notice that it contains : pri ority 15. This means that the GAVE-
FI NI SHED rule has higher priority than the PLAY rule (which has the default
value of 10), and so was preferred. Other methods of conflict resolution are
also available.

2.5 KnowledgeWorks Listener

The KnowledgeWorks Listener has already been shown to function as a Lisp
Listener. However it extends this with the ability of the Objects Browser to
match objects. When using the Objects Browser the Query pane contained pat-
terns which could be matched against the Object Base. These same patterns
can be entered into the KnowledgeWorks Listener. Enter (node ?obj ect) into
the Listener. This asks “Are there any node objects?””. A NODE object will be
returned. To ask for more solutions press the Next button. If there are more
you will be shown another, otherwise the listener displays the word NOand
the listener prompt reappears. If you do not want to see any more, just press
Ret ur n.

Try entering some of the other expressions from the Objects Browser, for
example (and (node ?n ani mal ?a) (test ?a)). Ifthe inputis not recog-
nized it is treated as Lisp.
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2.6 Debugging

2.6.1 Monitoring Forward Chaining Rules
Figure 2.8 KnowledgeWorks Rule Monitor

anaA Rule Monitor 1 = KW=LISER-PLAY
Dled » =@ hiyye 0S5
Select insbantiabinrs
_} Ml Unfired Instantiations Show Inferencing State: | -DEFAULT 55 |

E Marching Selecied Conditions

(KW-USER-ROOT KW-USER-:7R KW-USER 'NODE KW-USER: TNODE)
(NOT {KW-USER- CURRENT-NODE COMMON-PROLOG-? KW-USER:-NODE CC

FE————————————= b

Number af instanriaticns matthing sebected conditions: 1

Inscartiation I

W = FLEW-USER-ROOT 112F1ASES
MO = #<KW=-LSER NODE L 12FLASF=
=70

Handy

One of the problems with forward chaining rules is determining why they are
(or are not) being matched. To deal with this KnowledgeWorks has Monitor
Windows for forward chaining rules. To bring up a Monitor Window, select
the DEFAULT- CONTEXT in the Rule Browser, click on PLAY and choose Rule >
Monitor. Alternatively you can use the context menu to raise the Rule Monitor
window. A Rule Monitor window appears displaying in its upper pane the
conditions of the rule. Both are highlighted meaning they are matched (as
single conditions without reference to any variable bindings across condi-
tions) in the object base. If you select one or more of these conditions, the mes-
sage will change from "Number of instantiations matching selected

Debugging

17
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conditions: <n>"to "No instantiations matching selected conditions" depend-
ing on whether objects can be found in the object base to match all the selected
conditions at once (this takes account of variables bound across conditions).

By selecting the All Unfired Instantiations button, you can list any unfired
instantiations of the rule. In this case there is one unfired instantiation. Select-
ing this in the lower pane and then choosing Instantiations > Inspect raises an
Inspector tool displaying the variable bindings in the instantiation.

You can have any number of monitor windows (though at most one per rule).
At times (during rule execution, for example) the object base may change.
Monitor windows can be updated by choosing Window > Refresh from the
Rule Monitor menu bar, or Memory > Update Monitor Windows from the Knowl-
edgeWorks Listener. When you are single-stepping through rules (see below)
Monitor windows are updated automatically.

2.6.2 Single-Stepping Rules
Figure 2.9 KnowledgeWorks Gspy Window
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Select a rule, say, Y- N- QUESTI ON, in the Rule Browser and choose Rule > GSpy
from the menu bar. This brings up a Spy Window for the rule. In it you will
see the actions of the rule.
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Now enter (i nfer) in the Listener to run the demo again. Execution will stop
when this rule fires. A message in the listener will say that the rule Y- N- QUES-
TI ON has been called. Click on the Creep button at the bottom of the Listener to
single step through the rule. Watch the highlight move through the Spy
Window as you go. If you still have a Monitor Window for the PLAY rule it will
be updated automatically as you go.

Click on Leap at the bottom of the listener and it will “leap” to the end of the
rule. When you have finished, close the Spy Window (for example by Window
> Close Window) and press Leap in the Listener window to remove the break
point and continue normally.

At any point when rule execution is suspended by this mechanism, the other
KnowledgeWorks tools may be used, for example to examine the object base
(with the Objects Browser) or see which rules have fired (with the forward
chaining history). Spy Windows are available for backward chaining rules as
well, and they work in exactly the same way (they are set by selecting the rule
in the Rule Browser and choosing Rule > Gspy).

Debugging

19
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2.6.3 Editing Rule Definitions
Figure 2.10 KnowledgeWorks Editor
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Let us suppose that when the demo finishes we would like it to ask if we want
to play again. Find the definition for GAME- FI NI SHED (using the Rule Browser).
One line in the definition is commented out with a ; (semi-colon) at the start.
Remove the semi-colon and compile the new definition by choosing Defini-
tions > Compile from the editor menu bar. Press Space to return to the editor
view. This rule will now ask if the user wants to play again and execution will

only stop (the (r et ur n) instruction ends execution) if requested. Run the
demo to see this happen.

The rule FETCH NEW ANI MAL also has a commented-out line (repeat) which will
make it repeat its prompt until given an animal it does not already know.
Remove the semi-colon at the start of the line in and compile the new

20
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definition of the rule. Run the demo again and try giving the system an animal
it recognizes. It will prompt again. Give it an animal it does not recognize to
finish.

2.7 Lisp Integration
You can save your object base of animals by entering
(save-ani mal s "ny-ani nal -objs.lisp")

into the Listener. In the file of rules " ani mal -rul es. i sp" look at the function
save- ani mal s which does this. Note how the Lisp code directly uses the same
objects as the rules. If we used the Lisp code to modify the slots of the objects
the KnowledgeWorks rule interpreter would keep track.

Note: KnowledgeWorks CLOS obijects are ordinary CLOS objects and can be
used outside KnowledgeWorks rules.

2.7.1 LispWorks

The entire Common LispWorks programming environment is available from
the menus on the LispWorks menu bar and the LispWorks toolbar. See the Common
LispWorks User Guide for more details.
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2.8 Systems
Figure 2.11 KnowledgeWorks System Browser
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If you are familiar with LispWorks system definitions, look at the system defi-
nition for the animal demo in the Editor tool by choosing File > Open... and
navigating to the file exanpl es/ kw/ ani mal / def system | i sp. It contains a

KB- SYSTEMand a KB- | NI T- SYSTEM Examine the components of each system
(which can be source files or subsystems) using the System Browser which is
available from the Editor via Esc X Descri be Syst emor File > Browse Parent
System.

KB- SYSTEMs are reloaded when the rules are cleared. KB- | NI T- SYSTEMs are
reloaded when the object base is cleared.

Try this out by finding the KnowledgeWorks Listener and choosing Memory >
Clear Objects and Rules. Then enter (1 oad- system " AN MAL") into the Knowl-
edgeWorks Listener to reload the system ani mal . Both the files ani mal - r ul es
and ani nmal - obj s are reloaded. Now choose Memory > Clear Objects and reload
the ani mal system again and note how only the file ani mal - obj s is reloaded.



2.9 Exiting KnowledgeWorks

2.9 Exiting KnowledgeWorks

KnowledgeWorks is integrated with LispWorks so you cannot exit from
KnowledgeWorks independently. You can close individual KnowledgeWorks
windows by Window > Close Window. You can exit LispWorks by choosing
LispWorks > Quit LispWorks. If you have any unsaved edited files you will be
asked whether you wish to save them. There will be a final confirmation
before KnowledgeWorks quits.
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Rules

KnowledgeWorks rules are defined as follows:

<rule> ::=
(defrul e <rul e-nane> <direction> [<doc-string>] <body>)

<direction> ::= {:forward | :backward}

Every rule must have a uniqgue name which must also be distinct from any
KnowledgeWorks object class name and from any context (rule-group) name.
The expressions which form the body of a rule have the same syntax and
meaning regardless of whether they occur on the left or right hand side of a
forward or backward chaining rule. If doc-string is given, then it should be a
string. The value can be retrieved by calling the function docunent at i on with
doc-typerul e.

3.1 Forward chaining

3.1.1 Overview

Forward chaining rules consist of a condition part and an action part. The con-
dition part contains conditions which are matched against the object base. If
and only if all the conditions are matched, the rule may fire. If the rule is
selected to fire, the actions it performs are given in the action part of the rule.
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The process of selecting and firing a rule is known as the Forward Chaining
Cycle, and the forward chaining engine cycles repeatedly until it runs out of
rules or a rule instructs it to stop. KnowledgeWorks forward chaining rules
reside in a group of rules, or context, and may have a priority number associ-
ated with them for conflict resolution (choosing which of a set of eligible rules
may fire).

3.1.2 Forward Chaining Syntax
Forward chaining rule bodies are defined by:

<body> ::=
[: context <context-nane>]
[:priority <priority-numnber>]
<f orward- condi ti on>* --> <expressi on>*)

where <cont ext - nane> is the name of a context which has already been
defined (see Section 3.1.5, “Control Flow”) defaulting to def aul t - cont ext ,

and <pri ority-number > is a number (see Section 3.1.5, “Control Flow”)
defaulting to 10.

The syntax for forward-conditions is:

<forward-condition> ::=
<obj ect - condi ti on>
| (test <lisp-expr>)
| (not <forward-condition>+)
| (logical <forward-condition>+)

<obj ect-condition> ::=
(<cl ass-nane> <vari abl e> [ <obj ect-sl ot-condition>]*)

<obj ect-slot-condition> ::=
<sl ot - name> <ternp
<obj ect - condi ti on> is an object-base match where the variables (introduced
by "?") in <t er m> are bound (via destructuring) to the corresponding data in
the slot named by <sl ot - name>. <vari abl e> is a single variable bound to the
object matched.

Note: "?" on its own denotes an anonymous variable which always matches.
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(test <lisp-expr>) isaLisp test where <l i sp-expr>isany Lisp expression
using the variables bound by other conditions, and which must succeed
(return non-ni | ) for the condition to match. Computationally cheap Lisp tests
can frequently be used to reduce the search space created by the object base
conditions. Lisp tests, and any functions invoked by them, should not depend
on any dynamic global data structures, as changing such structures (and
hence the instantiations of the rule) will be invisible to the inference engine.
Lisp tests can depend on the values of slots in objects matched by preceding
object-base conditions only if the values are bound to variables in the rule
using the <obj ect - sl ot - condi ti on> syntax. They cannot depend on values
obtained by calling sl ot - val ue or a reader function.

(not <forward-condition>+) issimply a negated condition. A negated con-
dition never binds any variables outside its scope. Variables not bound before
the negation will remain unbound after it.

(1 ogi cal <forward-condition>+) is used to indicate clauses that describe
the logical dependencies amongst objects. See Section 6.4, “Logical Dependen-
cies and Truth Maintenance”for more details.

Note that if a forward chaining rule contains any conditions at all then it must
contain at least one object base reference of the form

(<cl ass-name> <variable> ...)
The syntax for expressions is:

<expression> ::=
<f orwar d- condi ti on>
| (erase <vari abl e>)
| (assert (<class-nane> <vari abl e>
[ <sl ot - name> <terne] *))
| (context <context-Ilist>)
| (return)
| (<I'i sp-expr> <ternp*)
| <goal >

<f orwar d- condi t i on> is a forward condition which must succeed for execu-
tion of the action part of the rule to continue.

(erase <vari abl e>) removes the instance bound to <vari abl e> from the
knowledge base. It is an error if <vari abl e> is bound to anything but a
KnowledgeWorks instance.
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(assert (<class-name> <variabl e> [ <sl ot-nanme> <ternp] *)) iS an asser-
tion which modifies the contents of the object base, where if <vari abl e> is
unbound a new object of the given class with the given slot-values is created,
and if it is bound, the object to which it is bound has its slots modified to the
given values.

(context <context-1list>) adds the given list of contexts to the top of
agenda (see Section 3.1.5, “Control Flow™).

(return) passes control to the top context on the agenda and removes it from
the agenda (see Section 3.1.5, “Control Flow”).

(<l'i sp-expr> <termp*) binds the result or results of calling <l i sp- expr>to
the <t er n»s with execution of the rule terminating if any bindings fail (if no
<t er mps are given execution will always continue).

<goal > may be any backward chaining goal expression (see Section 3.2, “Back-
ward Chaining™).

Note that in the action part of a rule, only backward chaining goals and object
base matches invoke the backward chainer.

3.1.2.1 Example

(defrule nmove-train :forward
:context train
(train ?train position ?train-pos)
(signal ?signal position ?signal-pos
col our green)
(test (= ?signal-pos (1+ ?train-pos)))

-->

((format t

~%lrain noving to position ~s"
?si gnal - pos))

(assert (signal ?signal colour red))

(assert (train ?train position ?signal-pos)))

specifies that if there is a train with a green signal directly in front then the
train may move on and the signal changes to red.
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3.1.3 Defining Forward Chaining Rules

Forward chaining rules may be defined and redefined incrementally. When
redefined all the instantiations of the rule are recreated. This means that
during execution of a rulebase the redefinition capability should be used with
care as previously fired instantiations will reappear and may fire again.

When a rule is redefined it inherits its order (with respect to the or der conflict
resolution tactic) from its initial definition. If this is not required, the rule
should be explicitly undefined before being redefined.

A forward chaining rule may be undefined by entering
(undefrul e <rul e- nane>)

A warning will be given if the rule does not exist.

3.1.3.1 Example

(undefrul e move-train)

3.1.4 The Forward Chaining Interpreter
The forward chaining rule interpreter may be invoked by the Lisp function
(infer [:contexts <context-list>])

where <cont ext - | i st > is a list of contexts where control is passed immedi-
ately to the first in the list, and the rest are placed at the top of the agenda. The
object base may or may not be empty when the forward chainer is started. The
i nf er function returns the final cycle number. When not specified,

<cont ext - | i st > defaults to (def aul t - cont ext).

3.1.5 Control Flow

3.1.5.1 The Agenda

The agenda is essentially a stack of rule groups (called contexts) which are still
awaiting execution. The initial invocation of the forward chainer and any sub-
sequent rule can cause contexts to be added to the top of the agenda. During

normal execution the forward chainer simply proceeds down the agenda con-
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text by context. When the agenda is empty, passing control on will terminate
the execution of the rule interpreter. This is a proper way to exit the forward
chainer.

3.1.5.2 Contexts

Contexts are the groups into which rules are partitioned. The context
def aul t - cont ext always exists. Contexts are defined by:

<context> ::=
(def cont ext <cont ext - name>

[:strategy <CRS>]

[rauto-returnt | nil]

[:meta <meta-actions>])

[: docunent ati on <doc-string>])
where <cont ext - nane> is a symbol, <CRS> is a conflict resolution strategy
defaulting to (priority recency order) (see below). If : aut o-ret urn is set
to t (the default) then when the context has no more rules to fire, control
passes to the next context on the agenda, but if itis ni | an error occurs (a rule
in the context should have issued a ( r et ur n) instruction explicitly). The : met a
option is necessary only if the default behavior of the context is to be modified
and is explained in Section 6.1.1, “Meta Rule Protocol”. If : docunent ati on is
given, then doc-string should be a string and the value can be retrieved by call-
ing the function docunent at i on with doc-type cont ext .

3.1.5.3 Conflict Resolution

Every context has its own conflict resolution strategy, specified in the
def cont ext form. A conflict resolution strategy is an ordered list of conflict
resolution tactics. A conflict resolution tactic may be any of the following:

e priority —instantiations of rules with the highest priority are pre-
ferred

e -priority —instantiations of rules with the lowest priority are pre-
ferred

e recency — the most recently created instantiations are preferred

e -recency —the least recently created instantiations are preferred
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< order — instantiations of rules defined/loaded earliest are preferred.
This favours the topmost rules in a file.

= -order —instantiations of rules defined/loaded latest are preferred

= specificity —the most specific rules are preferred (specificity is a
score where a point is awarded for every occurrence of a variable after
the first, every Lisp test, and every destructuring expression; the highest
score wins)

e -specificity —the least specific rules are preferred

< nea —(stands for Means End Analysis) instantiations are preferred
where the object corresponding to the topmost object-matching condi-
tion is more recently modified

= -mea —instantiations are preferred where the object corresponding to
the topmost object-matching condition is less recently modified

< | ex —(stands for LEXicographic) each instantiation is represented by
the (in descending order) sorted list of the most recently modified cycle
numbers of the objects in the instantiation; these lists are compared
place by place with an instantiation being preferred if it first has a larger
number in a particular position, or if it runs out first (hence the analogy
with lexicographic ordering)

e _|ex —the converse of the above.

The tactics are applied successively starting with the left-most until only one
instantiation is left or until all tactics have been applied when it is unspecified
which of the resulting set is chosen. For example, using the strategy (pri or -
ity recency) firstall the instantiations which are not of the highest priority
rule or rules (as given by the rule’s priority number) are discarded and then all
instantiations which were not created in the same forward chaining cycle as
the most recently created instantiation will be discarded. If more than one
instantiation is left it is unspecified which will be selected to fire.

Note that the strategy (1 ex speci ficity) isequivalent to the OPS5 strategy
LEX and (nea | ex specificity) isequivalent to the OPS5 strategy MEA,
hence the borrowing of these terms. For further information on LEX and MEA
in OPS5 the reader is referred to Programming Expert Systems in OPS5, by
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Brownston, Farrel, Kant and Martin (published by Addison-Wesley). How-
ever, KnowledgeWorks is not heavily optimized to use the tactics nea, - mea,
| ex or -1 ex.

3.1.6 Examples

(defcontext trains
:strategy (priority recency order)
rauto-return t)

(def context trains)

These two definitions are in fact equivalent.

3.1.6.1 Defining Contexts

A context may be defined and redefined. Redefining a context will clear all the
rules in the context.

A context may be undefined and removed by entering

(undef cont ext <cont ext - nane>)

3.1.7 Forward Chaining Debugging

Forward chaining debugging may be turned on by typing
(al | - debug)

and off by typing
(no- debug)

When KnowledgeWorks is started, debugging is on. Debugging allows the
actions of forward chaining rules to be single-stepped like backward chaining
rules (see Section 3.2.7, “Backward Chaining Debugging”), and also records
information on which objects are modified by which rules. For information on
how to use the debugging tools, refer to Chapter 5, “The Programming Envi-
ronment”.
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3.2 Backward Chaining

3.2.1 Overview

Backward chaining involves trying to prove a given goal by using rules to
generate sub-goals and recursively trying to satisfy those. The Knowledge-
Works backward chaining engine is an extension of the LispWorks Common
Prolog system which can match directly over KnowledgeWorks CLOS objects
(the object base). All the standard Common Prolog facilities and built in pred-
icates are available. For more detailed information the reader is referred to the
Appendix A, “Common Prolog”. Note that all the different ways of proving a
particular goal are defined together in the same form.

3.2.2 Backward Chaining Syntax

Backward chaining rule bodies are defined as:

<body> ::= <cl ause>+
<cl ause> ::= (<goal > <-- <expression>*)
<goal > ::= (<rul e-nane> <ternp*)

In each sub-clause of the rule, the goal must have the same arity (number of
arguments). Within each <t er m> destructuring is allowed and variables are
introduced by ? (and ? on its own denotes the anonymous variable which
always matches). <expr essi on> is as defined in Section 3.1.2, “Forward
Chaining Syntax”.

3.2.2.1 Example

(defrule link-exists :backward
((link-exists ?townl ?town2)

<- -

(or (link ?link townl ?townl town2 ?town2)

(link ?link town2 ?townl townl ?town2))

(cut))((link-exists ?townl ?town2)

<- -

(route-exists ?townl ?town2)))
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which says that a link exists between two towns either if there is a link object
between them in the object base or if there is a route between the towns. The
rout e- exi st s predicate would be defined by another backward chaining rule,
or might be in the Prolog database.

3.2.3 Objects

Backward chaining rules may refer to the object base using the standard

(<cl ass-name> <vari abl e> [<sl ot - name> <t ernp] *) syntax, and these
expressions are instantiated directly without creating any sub-goals. The

<cl ass- nane> of any CLOS class or KnowledgeWorks structure may not coin-
cide with any backward chaining <r ul e- name>. The Common Prolog database
may be used to record factual information but it is distinct from the object base
in that it may contain variables, and anything in it is inaccessible to the for-
ward chaining rule preconditions.

3.2.4 Defining Backward Chaining Rules

Backward chaining rules may be defined and redefined incrementally.

3.2.5 The Backward Chaining Interpreter

The backward chaining interpreter can be invoked from Lisp by the following
functions

(any <expr-to-instantiate> <expr-to-prove>)

which finds any solution to <expr - t o- pr ove> and instantiates <expr - t o-
i nstanti at e>, and

(findall <expr-to-instantiate> <expr-to-prove>)

finds all the solutions to <expr -t o- pr ove>, instantiates <expr-to-instanti -
at e> for each and returns these in a list.

For other interface functions to be called from Lisp the reader is referred to
Appendix A, “Common Prolog”.
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From the action part of a forward chaining rule the backward chainer is called
implicitly when a CLOS match or goal expression is used. The action part of
forward chaining rules and the antecedents of backward chaining rules are
syntactically and semantically identical.

3.2.5.1 Examples

(any '(?x is in (1 2 3)) '(menber ?x (1 2 3)))
returns

(Lisin (12 3))
The following expression:

(findall "(?x is in (12 3)) '(menber ?x (1 2 3)))
returns

((Lisin(123)(2isin(123)(3isin (12 3)))

3.2.6 Edinburgh Prolog Translator

Edinburgh syntax Prolog files may be compiled and loaded if they are given

. pl as a file extension. These are completely compatible with the Knowledge-
Works backward chaining rules. For more details refer to Section A.10, “Edin-
burgh Syntax”.

3.2.7 Backward Chaining Debugging

Backward chaining debugging follows the Prolog four port model. Backward
chaining rules may be “spied” (this is a Prolog term which corresponds to
tracing and single-stepping) which puts a break-point on them and means
they can be single-stepped when they are invoked. When forward chaining
debugging is on, the action part of forward chaining rules can be spied and
single-stepped in the same way when they are fired. Chapter 5, “The Pro-
gramming Environment”, explains this in detail. The leashing of the ports can
be adjusted, details are to be found in Section A.7, “Debugging”.

35



3 Rules

3.3 Common Lisp Interface

Arbitrary Lisp expressions may be called from rules. See Section 3.1.2, “For-
ward Chaining Syntax”.

36



A

Objects

The object base contains KnowledgeWorks CLOS obijects (including relational
database objects) and KnowledgeWorks structures. KnowledgeWorks CLOS
objects can be treated as ordinary CLOS objects and may be manipulated
directly from Lisp. KnowledgeWorks relational database objects may trans-
parently retrieve their slot values from a relational database using the Lisp-
Works object-oriented relational database interface.

KnowledgeWorks structures are more efficient but reduced functionality
CLOS objects similar in spirit to Lisp structures. Values in the slots of these
objects should not be destructively modified unless these values are them-
selves KnowledgeWorks objects. This is because the rule interpreter keeps
track of the changes to the slots, and a destructive operation is likely to bypass
this process.

4.1 CLOS objects

A KnowledgeWorks CLOS class may not have a class name which coincides
with any rule, context or KnowledgeWorks structure (See Section 4.3, “Knowl-
edgeWorks Structures”). KnowledgeWorks CLOS classes fall into one of two
categories, either unnamed or named. Named objects can be given a name (or
they use a default name) and can be referred to by name. Otherwise, named
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and unnamed objects have equivalent functionality. CLOS objects may be
made by the Common Lisp function nake- i nst ance, taking the same argu-
ments. An unbound slot will return : UNBOUND until set.

Name clashes are arbitrated by *si gnal - kb- name- cl ash* and signal an error
by default. See the reference manual page.

4.1.1 Unnamed Classes

Unnamed classes may be defined by the macro def - kb- cl ass which takes the
same arguments as the def cl ass macro. It is identical to using defclass and
supplying the KnowledgeWorks mixin st andar d- kb- obj ect if none of the
superclasses already contains it. The function make- i nst ance may be used to
create instances of the class.

4.1.2 Named Classes

A named KnowledgeWorks CLOS class is defined by the macro def - named-
kb- cl ass which is syntactically identical to the Common Lisp def cl ass
macro, and semantically identical with the exception that it adds a
KnowledgeWorks mixin class named- kb- obj ect if none of the superclasses
already contains it, and makes the default name for the objects be a symbol
generated from the class name. Classes defined by def - naned- kb- cl asscon-
tain a name slot which those defined by def - kb- cl ass do not.

The function make- i nst ance can be given the initialization argument

: kb- name to specify a name. If not specified, a default name is generated from
the name of the class. All names must be distinct as regarded by eq. The func-
tion

(get - kb-obj ect <name>)
retrieves the instance from its name. The function
(kb-nanme <obj ect >)

returns the name of the given object.



4.2 Relational Database Objects

4.1.2.1 Examples

(def - naned- kb-cl ass truck ()
((location :initarg :|ocation)
(destination :initarg :destination)))
(rmake-instance 'truck
i kb-nanme 'fordl
:location ’'canbridge)

creates the instance #<KB- OBJECT FORD1>.
(make-instance 'truck :location 'l ondon)
creates the instance #<KB- OBJECT TRUCK123>, and
(get-object ’'fordl)
returns #<KB- OBJECT FORD1> and
(nane (get-object 'fordl))
returns FORDL. The class definition
(defclass truck (named-kb-object) ...)

would have been identical except that the second truck would have been
given a name such as OBJECT345 rather than TRUCK123 (as def - naned- kb-
cl ass overrides the inherited initform for the kb-name slot

(gentenp "OBJECT") with a more specific one (gent enp <cl ass- nane>) ).

4.2 Relational Database Objects

A CLOS/SQL class may also be given the KnowledgeWorks mixin class,
enabling rules to refer to these objects as if there were no database present.
However, their database functionality carries over transparently. For example,
consider the case where a slot in the database class is designated for deferred
retrieval from the database. When the rulebase queries the contents of the slot,
a database query will automatically be generated to retrieve and fill in the
value of the slot, and the rulebase will continue as if the value had been there
in the first place.

Details on the LispWorks Common SQL interface can be found in the Lisp-
Works User Guide.
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4.2.1 Example

(sql : def-viewclass vehicle
(st andar d- db- obj ect st andar d- kb- obj ect)
((vehicle_no :db-kind :key)
(keeper)
(owner :db-kind :join
:db-info (:hone-key :keeper
:foreign-key person_id
iretrieval :deferred
1join-class person))))

defines a database class vehi cl e where the per son object in the keeper slot is
retrieved from the per son table in the database using the value of the keeper
slot as key, only when queried. In the list of superclasses, st andar d- kb- obj ect
should appear after sqgl : st andar d- db- obj ect .

4.2.2 Extended Example

The following example is a complete segment of code which allocates person
objects to vehicle objects. Note how once the class definitions have been made,
the rules do not in any way reflect the fact that there is an underlying data-
base. The example output assumes a database initialized by the following SQL
statements:

drop table VEH CLE ;
create table VEH CLE

(PLATE CHAR(8) NOT NULL, MAKE CHAR(20),

PRI CE | NTECER, OMER CHAR(20) );

grant all on VEH CLE to public
insert into VEH CLE val ues

(" E265 FOO, 'VAUXHALL', 5000, '');
insert into VEH CLE val ues

(" XDG 7928, 'ROLLS', 50000, '');
insert into VEH CLE val ues

(" F360 OOL', 'FORD , 4000, ' PERSEPHONE );
insert into VEH CLE val ues

(' H151 EEE, 'JAGUAR , 15000, '');
insert into VEH CLE val ues

(' Gr22 HAD', ' SKODA', 500, '');



drop tabl e PERSCN ;
create tabl e PERSON
(NAMVE CHAR(20) NOT NULL, SALARY | NTEGER,

EMPLOYER CHAR(20) ) ;
insert into PERSON values (' FRED , 10000,
insert into PERSON val ues (' HARRY', 20000,
insert into PERSON val ues (' PHOEBE , 5000,
insert into PERSON values (' TOM, 50000, '’
insert into PERSON val ues
(' PERSEPHONE' , 15000, 'F360 OOL', 'ICL');

drop tabl e COVPANY ;
create tabl e COVPANY
(NAME CHAR (20), PRODUCT CHAR(10) );

4.2 Relational Database Objects

VEHI CLE CHAR(8),

", U IBM);
!1’ !FmDi);
R S

. TAOVE )

insert into COVPANY values ('I1BM, 'COWUTERS );
insert into COVWANY values (' FORD , 'CARS );
insert into COVPANY values (’I1CL", * COWUTERS );
insert into COVPANY val ues (' ACME , ' TEAPOTS );

Below is an example rulebase that analyses the database and outputs a sug-
gestion as to which vehicle should be allocated to which person. The full code
and the SQL statements to set up the database are included in the examples

distributed with KnowledgeWorks.
(i n-package "KW USER")

dat abase owner

owner person obj ect

[REIN)

the vehicle class maps onto the car table in the
is ajoin slot which | ooks up the
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(sql : def-viewcl ass vehicle
(sql : standar d- db- obj ect st andard-kb- obj ect)
((nunmber-pl ate :accessor vehicl e-nunber-pl ate
:type (string 8)
:db- ki nd : key
:colum pl ate)
(make :accessor vehicl e- make
:type (string 20)
:db-kind : base
:col um make)
(price :accessor vehicle-price
:type integer
:db-kind : base
:colum price)
(owner-nanme :type (string 20)
:db- ki nd : base
:col um owner)
(owner :accessor vehicl e- owner
:db-kind :join
:db-info (:home-key owner-nane
:forei gn-key nane
;join-class person
:set nil
:retrieval :deferred))))

;;: the person class maps onto the person table in the
;,, database

;75 vehicle is a join slot which | ooks up the owned
77, vehicle object

;55 company is a join slot which | ooks up the conpany
;. object
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(sql : def -vi ew cl ass person
(sql : standar d- db- obj ect st andard-kb- obj ect)
((name :accessor person-nane
:type (string 20)
:db-kind : key
:col um nane)
(sal ary :accessor person-salary
:type integer
:db-ki nd : base
:colum sal ary)
(vehi cl e-nunber-plate :type (string 8)
:db-ki nd : base
:colum vehicl e)
(vehicl e :accessor person-vehicle
:db-kind :join
:db-info (:home-key vehicl e-nunber-plate
:forei gn-key nunber-plate
:join-class vehicle
:set nil
:retrieval :deferred))
(enpl oyer :type (string 20)
:db-ki nd : base
:col um enpl oyer)
(conpany :accessor person-conpany
:db-kind :join
:db-info (:home-key enpl oyer
:forei gn-key name
:join-cl ass conpany
:set nil
:retrieval :deferred))))

;;; the conpany class nmaps onto the conpany table in
;7 the database

(sql : def -vi ewcl ass conpany
(sql : st andar d- db- obj ect st andar d- kb- obj ect)
((name :accessor conpany-name
:type (string 20)
:db- ki nd : key
:col um nane)
(product :accessor conpany-product
:type (string 10)
:db-ki nd : base
:colum product)))

Relational Database Objects
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;7 here we assunme we have a dat abase connected with
;7 the correct data in it - if we do we retrieve all
;7 the person and vehicle objects but conpany objects
;7 will be retrieved only when needed by querying

i, the conpany slot of the person objects

(i f sql:*default-database*
(progn (sql:select "vehicle)
(sql : sel ect 'person))
(format t
"~0P| ease connect to a database with
contents ~ created by file data.sqgl"))
;;; to store which vehicles a person can drive
(def -kb-struct vehicl es-for-person person vehicl es)
(def cont ext dat abase-exanple :strategy (priority))

;;; for every person initialise the list of vehicles they
;7 can drive

(defrule init-vehicles-for-person :forward
. cont ext dat abase- exanpl e
(person ?person vehicle nil)
-->
(assert (vehicles-for-person ? person ?person vehicles nil)))

;75 for every vehicle a person can drive which hasn't yet
::; been included in the list, add it to the |ist

(defrul e vehicle-for-person :forward
: cont ext dat abase- exanpl e
(person ?person vehicle nil)
(vehicle ?vehicle owner nil)
(vehi cl es-for-person ?c-f-p
person ?person
vehi cl es ?vehi cl es)
(test (not (menber ?vehicle ?vehicles)))
; has it been incl uded?
-->
(vehi cl e- ok-for-person ?vehicle ?person)
; check if ok to drive vehicle
(assert (vehicles-for-person ?c-f-p vehicles
(?vehicle . ?vehicles))))

;7. rules expressing what vehicles a person can drive
;;, if they have no enployer they can only drive a

;;; skoda otherwise they will refuse to drive a skoda
77, anyone will drive a rolls or a jag.
;55 they' Il only drive a ford or vauxhall if salary is

;. less than 40k
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(defrul e vehicl e-ok-for-person : backward

((vehicl e-ok-for-person ?vehicl e ?person)
<- -

(person ?person conpany nil)

(cut)

(vehi cl e ?vehicl e make " SKODA"))
((vehicl e-ok-for-person ?vehicle ?person)
<- -

(vehicl e ?vehicle make " SKODA")

(cut)

(fail))
((vehi cl e-ok-for-person ?vehicle ?person)
<- -

(or (vehicle ?vehicle make "ROLLS")
(vehicl e ?vehicl e nake "JAGUAR"))
(cut))
((vehi cl e-ok-for-person ?vehicle ?person)
<- -
(or (vehicle ?vehicle make "VAUXHALL")
(vehicl e ?vehicle make "FORD"))
(person ?person salary ?sal ary)
(test (< 7?salary 40000))))

4.2 Relational Database Objects
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;;, next to rules are just sinple allocation rules,
;;, trying out each possibility until one fits

(defrul e all oc-vehicl es-to-persons : backward
((all oc-vehicl es-to-persons ?allocs)
<- -
(alloc-internal nil nil nil ?allocs)))

(defrule alloc-internal :backward
((alloc-internal ?done-persons ?done-vehicles
?al | ocs ?al |l ocs)
<- -
(not (and (vehicles-for-person ? person ?person)
(not (nenber 7?person ?done-persons))))
(cut))
((alloc-internal ?done-persons ?done-vehicles
?al | ocs-so-far ?all ocs)
<- -
(vehi cl es-for-person ? person ?person
vehi cl es ?vehi cl es)
(not (nenmber 7?person ?done-persons))
(menber ?vehicle ?vehicles)
(not (nenmber ?vehicl e ?done-vehicles))
(alloc-internal (?person . ?done-persons)
(?vehicle . ?done-vehicl es)
((?person . ?vehicle) . 7?allocs-so-far)
?allocs)))

77, find a solution and print it out

(defrule find-solution :forward
:cont ext dat abase- exanpl e

tpriority 5
(not (not (vehicles-for-person ?)))
-->

(al I oc-vehicl es-to-persons ?sol ution)
((dolist (pair ?solution)
(format t "~%A drives ~A"
(person-nane (car pair))
(vehicl e-nunber-plate (cdr pair))))))

Below is sample output from the rulebase with SQL recording turned on to
demonstrate the SQL statements that are automatically passed to the database
by manipulating the objects:
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KWUSER 53 > (infer :contexts '(database-exanple))
( SELECT VEHI CLE. PLATE, VEH CLE. MAKE, VEHI CLE. PRI CE, VEHI CLE. ONNER
FROM VEHI CLE

WHERE ( VEHI CLE. PLATE = * F360 OCL'))
(SELECT VEH CLE. PLATE, VEHI CLE. MAKE, VEHI CLE. PRI CE, VEHI CLE. OA\NER
FROM VEHI CLE

WHERE ( VEHI CLE. PLATE = "))
( SELECT VEHI CLE. PLATE, VEHI CLE. MAKE, VEHI CLE. PRI CE, VEHI CLE. ONNER
FROM VEHI CLE

WHERE (VEHI CLE. PLATE = ''))

( SELECT

PERSON. NAME, PERSON. SALARY, PERSON. VEHI CLE, PERSON. EMPLOYER
FROM PERSON WHERE ( PERSON. NAVE = '’ ))

(SELECT VEH CLE. PLATE, VEHI CLE. MAKE, VEHI CLE. PRI CE, VEHI CLE. O\NER
FROM VEHI CLE

WHERE (VEHI CLE. PLATE = ''))

( SELECT

PERSON. NAME, PERSON. SALARY, PERSON. VEHI CLE, PERSON. EMPLOYER
FROM PERSON WHERE ( PERSON. NAVE = '’ ))

(SELECT VEH CLE. PLATE, VEHI CLE. MAKE, VEHI CLE. PRI CE, VEHI CLE. O\NER
FROM VEHI CLE

WHERE (VEHI CLE. PLATE = ''))

( SELECT

PERSON. NAME, PERSON. SALARY, PERSON. VEHI CLE, PERSON. EMPLOYER
FROM PERSON WHERE ( PERSON. NAME = '’ ))

( SELECT

PERSON. NAME, PERSON. SALARY, PERSON. VEHI CLE, PERSON. EMPLOYER
FROM PERSON WHERE ( PERSON. NAVE = '’ ))

( SELECT

PERSON. NAME, PERSON. SALARY, PERSON. VEHI CLE, PERSON. EMPLOYER
FROM PERSON WHERE ( PERSON. NAVE = ’ PERSEPHONE' ))

( SELECT COMPANY. NAME, COVPANY. PRODUCT FROM COMVPANY

WHERE ( COVPANY. NAME = * FORD ))

( SELECT COMPANY. NAME, COVPANY. PRODUCT FROM COVPANY

WHERE ( COVPANY. NAME = ’ ACVE'))

( SELECT COMPANY. NAME, COVPANY. PRODUCT FROM COMPANY

WHERE ( COVPANY. NAME = ' 1 BM))
( SELECT COMPANY. NAVE, COVPANY. PRODUCT FROM COVPANY
WHERE ( COVPANY. NAME = ' "))

HARRY drives E265 FOO
TOM drives XDG 792S
FRED drives H151 EEE
PHCEBE drives G722 HAD
26
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4.3 KnowledgeWorks Structures

An optimization for improved performance is to replace CLOS objects by
KnowledgeWorks structures when the objects are not needed outside the
rules, or the full power of object-oriented programming is not required.
Within rules they behave the same, although they are not proper CLOS
objects. This is discussed in detail in Section 6.2, “Optimization”.



5

The Programming Environ-
ment

The KnowledgeWorks programming environment is designed for the devel-
opment of rules. KnowledgeWorks applications will typically contain a mix-
ture of programming styles and so the LispWorks programming environment
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5 The Programming Environment

is available from the menus on the KnowledgeWorks Podium. This chapter
deals with KnowledgeWorks specific tools but see the Common LispWorks User
Guide for more details on the LispWorks tools.

Figure 5.1 KnowledgeWorks Menu

Window
Close Window HW

Loom Window
Minimize Window HM

Refresh

Clone

Customize

Window Preferences...

Taols

KnowledgeWworks Listener
Editor
Rules
Editor 1 - _lispworks Objects
Listener 1 FC History

+ Listener 2 Classes
Systems

Interface

All KnowledgeWorks windows can be closed independently of the others by
choosing Window > Close Window. You can switch between windows by choos-
ing Window > window-name.
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5.1 The KnowledgeWorks Listener

Figure 5.2 KnowledgeWorks Listener
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The KnowledgeWorks Listener is obtained by choosing Window > Knowledge-
Works > Listener. This tool is based on the LispWorks Common Prolog Logic
Listener (see Appendix A, “Common Prolog” for further details). Input is
taken as being a goal expression to be satisfied unless no predicate of that
name and arity (number of arguments) exists in which case it is taken as a Lisp
expression. That is, the input may be either

<expressi on>
as defined in Section 3.1, “Forward chaining”, or
<l i sp-expr>

with the former interpretation taking priority when ambiguous. Interaction is
Prolog-style, so when the bindings which satisfy a goal are printed, pressing
Ret ur n terminates execution, and entering ; (semi-colon) and Ret ur n (or just
clicking on the Next button at the bottom) looks for the next solution to the
goal.

The File, Leashing and Spy menus behave as for the Common Prolog Logic Lis-
tener (see Appendix A, “Common Prolog”) and the Values, Debug and History
menus behave as for the Lisp Listener (see the Common LispWorks User Guide).
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5.2 The Editor

Figure 5.3 KnowledgeWorks Editor
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The KnowledgeWorks Editor is created by choosing Window > Knowledge-
Works > Editor. It is the same as the LispWorks Editor tool. Please see the
Common LispWorks User Guide for more information on the editor tool and the
LispWorks Editor User Guide for information on the various editing commands.

5.3 Clearing KnowledgeWorks

The KnowledgeWorks object base (all the KnowledgeWorks CLOS objects and
any optimized structures) may be cleared by choosing Memory > Clear Objects
from the KnowledgeWorks Listener, or by calling the function r eset .



5.4  The System Browser

KnowledgeWorks rules may be cleared by choosing Memory > Clear Rules from

the KnowledgeWorks Listener, or by calling the function cl ear - r ul es. Clear-

ing the rules does not remove the default context def aul t - cont ext but all the

rules in it are removed.

KnowledgeWorks object base and rules may be cleared by choosing Memory >

Clear Objects and Rules from the KnowledgeWorks Listener, or by calling the
function cl ear - al | . CLOS class definitions remain in effect.

5.4 The System Browser

Figure 5.4 KnowledgeWorks System Browser
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The KnowledgeWorks system browser is obtained by choosing Window >
KnowledgeWorks > Systems. It is the same as the LispWorks System Browser,
but includes new types of system:

e :kb-system which are reloaded when the KnowledgeWorks rules are
cleared (see Section 5.3 on page 52).

e :kb-init-system which are reloaded when the KnowledgeWorks
object base is cleared (see Section 5.3 on page 52).
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For more information on LispWorks systems, see the Common Defsystem
chapter in the LispWorks User Guide. For more information about the System
Browser tool, see the Common LispWorks User Guide.

5.5 The Class Browser

Figure 5.5 KnowledgeWorks Class Browser
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The Class Browser is obtained by choosing Window > KnowledgeWorks >
Classes. It is the same as the LispWorks Class Browser except that

e it appears with an initial focus on st andar d- kb- obj ect
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< when looking at a KnowledgeWorks class the Classes menu and context
menu contain an Inspect Instances command which allows you to look

at the instances of the class.

Figure 5.6 Inspecting instances from the Class Browser
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This raises an Inspector tool with a list of all the instances.

Figure 5.7 KnowledgeWorks Instances Inspector
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Any of the instances displayed in the lower pane may itself be inspected by
double-clicking on it.

Other options available in the Class Browser include:

Superclasses and Subclasses tabs to draw a graphs of the superclasses
or subclasses of the class being looked at

Slots and Initargs tabs to show how the instances can be accessed and
initialized.

Functions tab to show the generic functions or methods defined on this
class, either directly or by inheritance

Additionally the Classes menu contains a Browse Metaclass command which
browses the class of this class.

Further details can be found in the Common LispWorks User Guide.



5.6 The Objects Browser

Figure 5.8 KnowledgeWorks Objects Browser
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The Obijects Browser is obtained by choosing window > KnowledgeWorks >
Objects. Any <expr essi on> (See Section 3.1, “Forward chaining’) may be

The Objects Browser

entered into the Query pane. This expression may be a query about the object
base or any expression for the backward chainer to prove. The Pattern pane
contains the pattern to be instantiated for each solution of the query. If left

blank, the pattern used is the query itself.

The Show Inferencing State dropdown allows you to choose which named

inferencing state is used to supply the object base for the query.
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The Preset query/pattern pane offers a convenient way to examine instances on
a per-class basis. All the instances of a class class-name known to Knowledge-
Works (either a CLOS class or a KnowledgeWorks structure class) may be
examined by selecting class-name, and all the instances in the object base may
be viewed by selecting All classes.

The package used to read and print symbols may be modified by choosing
Window > Window Preferences... and entering a package name into the dialog.
Clicking OK will update the tool.

The pane below the query displays all the instantiations of the query, and if
the entries refer to an object (so are of the form (<cl ass- name> <obj ect >
...) orjust <obj ect >) double-clicking on them will display the slot names
and values, and information on when the object was created or modified (if
debugging is turned on) in the bottom pane. The selected query item may be
inspected by choosing Instantiations > Inspect.

The Objects Browser may be updated by positioning the mouse in either the
Query or the Pattern pane and pressing Ret ur n or by choosing Window >
Refresh.



5.7 The Rule Browser

5.7 The Rule Browser
Figure 5.9 KnowledgeWorks Rule Browser
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The Rule Browser may be obtained by choosing Window > KnowledgeWorks >
Rules. It displays contexts and their rules. The Contexts pane at the top allows
you to select from a drop-down list either a forward chaining context or the
special pseudo-context containing all the backward chaining rules. The Rules
pane lists the rules for the selected context.

The Context menu acts on the selected context. Choosing Context > Find Source
will bring up the definition of the context in the file where it was defined, and
choosing Context > Gspy will bring up a Spy Window (see Section 5.8, “Debug-
ging with the Environment”) for the context, displaying the meta-interpreter
(see Section 6.1.1, “Meta Rule Protocol”) for the context if one is defined. If
debugging is turned on a meta-interpreter is always defined. Choosing Con-
text > NoGspy will remove the Spy Window (see Section 5.8, “Debugging with
the Environment”).
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The Rule menu acts on the rule selected in the lower pane. All rules may be
edited by choosing Rule > Find Source. Spy Windows can be brought up or
removed by choosing Rule > Gspy. Forward chaining rules may have Monitor
Windows (see Section 5.8 on page 60) brought up or removed by choosing
Rule > Monitor (this command is disabled when a backward chaining rule has
been selected). These are explained in Section 5.8, “Debugging with the Envi-
ronment”.

The package used for displaying symbols may be modified by choosing
Window > Window Preferences... and entering a package name into the dialog.
Clicking OK will update the tool.

5.8 Debugging with the Environment

5.8.1 Spy Windows
Figure 5.10 KnowledgeWorks Gspy Window
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Spy Windows display graphically the actions or subgoals a rule (either for-
ward or backward chaining) will invoke when it fires. A Spy Window may be
obtained by selecting a rule in the Rule Browser and choosing Rule > Gspyor
choosing Gspy from the context menu.or by choosing Spy > Gspy in the



5.8 Debugging with the Environment

KnowledgeWorks Listener. Spying can be cancelled by closing the Spy
Window or by choosing Spy > NoSpy or Spy > NoSpy All from the Knowledge-
Works Listener.

Selecting one of the graph nodes in the top pane of the Spy Window displays
the full text of the box in the pane below. Choosing Gspy from the context
menu brings up a Spy Window for the goal in the box.

When the rule being displayed fires, execution stops and the buttons at the
bottom of the KnowledgeWorks Listener allow the rule to be single-stepped.
Clicking on the Creep button steps through the rule, and Leap advances to the
end of the rule (unless any of the intervening goals invoke another rule which
has been spied). When single-stepping, a highlight marks the action or goal
being performed. When execution is suspended in this manner, any of the
KnowledgeWorks tools or browsers may be used.

More details on single stepping through rules are in Appendix A, “Common
Prolog”.
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5.9 Monitor Windows

Figure 5.11 KnowledgeWorks Rule Monitor
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Monitor Windows allow the preconditions of forward chaining rules to be
monitored. They may be obtained by choosing Rule > Monitor or by choosing
Spy > Monitor Rule from the KnowledgeWorks Listener.

The top part of the window is the Select instantiations pane, as described
below. The lower part displays a list of either fired or unfired instantiations.
This list is not kept up to date if the rulebase is executing with debugging
turned off. To examine a binding in a displayed instantiation, select the corre-
sponding line and choose Instantiations > Inspect. This shows the objects them-
selves in a LispWorks Inspector tool, so double-clicking on one of the entries
will cause that entry to be inspected. See the Common LispWorks User Guide for
more details.
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The Show Inferencing State dropdown allows you to choose which named
inferencing state is used to find the instantiations.

When the All Unfired Instantiations button is selected, the unfired instantiations
are displayed.

When the Matching Selected Conditions button is selected, the instantiations
that match all of the selected preconditions are displayed. The topmost shows
the preconditions of the rule. Any conditions that are matched by the object
base are highlighted. This highlighting means the condition is matched with-
out reference to any of the other conditions. A message indicates the number
of instantiations matching the highlighted preconditions. A group of precon-
ditions matched individually (hence highlighted) may not be matched
together if, for instance, variables were bound across them.

If a rule has the conditions, say,

(person ?personl father ?person)
(person ?person2 son ?person)
(test (not (eq ?person nil)))

these would be displayed in the top pane of the Rule Monitor Window. The
first two would be highlighted if the object base contained a person object. But
instantiations would only be displayed if there was a per son object with the
same f at her value as some (other) per son object has son.

The selection of conditions may be toggled by left-clicking. So in the above
example the last condition could be selected also by clicking on it, and there
would be no instantiations displayed if the only consistent value of ?per son
wasnil .
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5.9.1 Forward Chaining History
Figure 5.12 KnowledgeWorks Forward Chaining History

&8 5 A F C History I
O ([ R
Current cycle number: @ Show Inferencing State: | -DEFAULT Y
Contests FC Cycles
1 KW DEFAULT-CONTEXT 12 3 4 5 6
KN-USER: : PLAY . jL__t
EN-USER: ;=M - RS TTON [ i
KN-USER: : AMTMAL -DUESTTON l
EN-USER: :MEW-CERS TION [ |
EN-USER: : GAME - FINISHEL :.

Rty

DEFAULT-CONTEXT

The Forward Chaining History may be viewed by choosing Window > Know!-
edgeWorks > FC History. This displays the rules which the forward chaining
engine has fired. The left pane lists sequentially the contexts which have been
executed, with the cycle number in which they were entered. These can be
clicked on to show in the right pane, the history for that context. The rules in it
are listed down the left, and the cycle numbers along the top, forming a two
dimensional grid.

Each position in the grid indicates the status of the rule in that cycle. A colored
box indicates that the rule fired. A half-colored box indicates that the rule
fired, but that the invocation of the backward chainer on the right-hand side
failed at some point. There can only be one colored or half-colored box per
cycle. An outlined box indicates that the rule was in the conflict set but was
not chosen to fire. Absence of any icon indicates that the rule was not even in
the conflict set.

If the forward chaining history is displayed while a rule is executing (for
example, while the rule is being single stepped) a half-colored box is dis-
played as execution is not complete.
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The Rule menu can be used in the same way as in the Rule Browser, described

in Section 5.7, “The Rule Browser”. It applies to the selected rule in the FC
Cycles pane.

The Show Inferencing State dropdown allows you to choose which named
inferencing state is examined.

This tool is not available when debugging is turned off.
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6

Advanced Topics

6.1 Control Flow

6.1.1 Meta Rule Protocol

The meta rule protocol (MRP) reifies the internal actions of the forward
chainer in terms of backward chaining goals. This allows the user to debug,
modify, or even replace the default behavior of the forward chainer. The basic
hooks into the Forward Chaining Cycle provided by the MRP include conflict
resolution and rule firing. Each context may have a meta-rule defined for it
which behaves as a meta-interpreter for that context. For example, if no meta-
rule is defined for a context it behaves as if it were using the following meta-
rule:

(defrul e ordi nary-context :backward
((ordi nary-cont ext)
<- -
(start-cycle)
(instantiation ?instantiation)
(fire-rule ?instantiation)
(cut)
(ordi nary-context)))
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This rule describes the actions of the forward chaining cycle for this context.
Firstly st art - cycl e performs some internal initializations and updates the
conflict set. It is essential that this is called at the start of every cycle. Next the
preferred instantiation is selected from the conflict set by the call to i nst ant i -
ati on and is stored in the variable ?i nst anti at i on. The rule corresponding to
this is fired (by fi re- rul €) and the recursive call to or di nar y- cont ext means
that the cycle is repeated. The cut is also essential as it prevents back-tracking
upon failure. Failure occurs when there are no more instantiations to fire (the
i nst anti ati on predicate fails) and this causes control to be passed on as nor-
mal.

A meta-rule may be assigned to a context with the : met a keyword of the def -
cont ext form. The argument of the : met a keyword is the list of actions to be
performed by the context. For example, a context using the above ordinary
meta-interpreter can be defined by

(defcontext my-context :meta ((ordinary-context)))
This implicitly defines the rule

(defrul e ny-context :backward
((my-context)
<- -

(ordi nary-context)))

and whenever this context is invoked, the rule of the same name is called. The
context could equally well have been defined as

(def context my-context :neta
((start-cycle)
(instantiation ?instantiation)
(fire-rule ?instantiation)
(cut)
(my-context)))

Sometimes it is useful to manipulate the entire conflict set. For this purpose
the action (conflict-set ?conflict-set) will return the entire conflict setin
the given variable, in the order specified by the context’s conflict resolution
strategy. The actions

(conflict-set ?conflict-set)
(rmenber ?instantiation ?conflict-set)

are equivalent to
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(instantiation ?instantiation)
although the latter is more efficient.

Now that the user has access to the instantiations of rules, functions are pro-
vided to examine them.

6.1.1.1 Functions defined on Instantiations

The following functions may be called on instantiations:
i nst-rul ename (instantiation)

which returns the name of the rule of which this is an instantiation.
i nst-token (instantiation)

which returns the list of objects (the token) which match the rule. These appear
in reverse order to the conditions they match.

i nst -bi ndings (instantiation)

which returns an a-list of the variables matched in the rule and their values.

6.1.1.2 A Simple Example

This meta-rule displays the conflict set in a menu to the user and asks for one
to be selected by hand on each cycle. Note that we have to check both that
there were some instantiations available, and that the user selected one (rather
than clicking on the Abort button).

(defrul e manual - cont ext : backward
((manual - cont ext)
<- -
(start-cycle)
(conflict-set ?conflict-set)
(test ?conflict-set)
; are there any instantiations?
((select-instantiation ?conflict-set)
?instanti ati on)
(test ?instantiation)
; did the user pick one?
(fire-rule ?instantiation)
(cut)
(manual - context)))
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where the function sel ect -i nst anti ati on could be defined as

(defun select-instantiation (conflict-set)
(tk:scrollable-nmenu conflict-set
ititle "Select an Instantiation:"
:nane-function # (Il anbda (inst)
(format nil "~S: ~S"
(i nst-rul ename inst)
(inst-bindings inst))))

Now a context could be defined by

(defcontext a-context :strategy ()
:nmeta ((nanual -context)))

6.1.1.3 A Simple Explanation Facility

Meta-rules can also be used to provide an explanation facility. A full imple-
mentation of the explanation facility described here is included among the
examples distributed with KnowledgeWorks, and is given also in
Appendix B.2, “Explanation Facility”

Suppose we have a rule about truck scheduling of the form

(defrule allocate-truck-to-1oad :forward
(load ?I size ?s truck nil destination
?d | ocation ?loc)
(test (not (eq ?d ?loc)))

(truck ?t capacity ?c load nil location ?loc)
(test (> ?c ?s))
-->

(assert (truck ?t load ?1))
(assert (load ?I truck ?t)))

and we wish to add an explanation by entering a form like
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(defexplain allocate-truck-to-Ioad
why ("~S has not reached its destination
~S and ~ does not have a truck

al l ocated, ~ ~S does not have a | oad
allocated, and ~ with capacity ~Sis
able to carry the load, ~ and both

are at the sane place ~S'
?1 ?2d ?t ?c ?loc)
what ("~S is scheduled to carry ~Sto ~S'
?t ?1 ?d)
:because ("A custoner requires ~S to be
noved to ~S" ?I ?d))

where the : why form explains why the rule is allowed to fire, the : what form
explains what the rule does and the : because gives the ultimate reason for
firing the rule.

The stages in the implementation are as follows:

= Define a macro called def expl ai n to store the explanation information
in, say, a hash-table keyed against the rule name

« Define a function add- expl anat i on takes an instantiation, fetches the
explanation information from the hash-table and the variable bindings
in the instantiation, and adds the generated explanations to another
global data structure, something like:

(defun add-instantiation (inst)
(let ((explain-info
(gethash (inst-rul enane inst)
*expl ai n-tabl e*)))
(when expl ai n-info
(do-the-rest explain-info
(inst-bindings inst))))))

< Implement graphical tools to browse the resulting explanations

= Define a meta-interpreter for which will produce explanations, for
example:

Control Flow
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(defrul e expl ai n-context :backward
((expl ai n- cont ext)
<- -
(start-cycle)
(instantiation ?inst)
((add- expl anati on ?inst))
(fire-rule ?inst)
(cut)
(expl ai n-context)))

6.1.1.4 Reasoning with Certainty Factors

Another application of meta-rules is in the manipulation of uncertainty. A full
implementation of the uncertain reasoning facility described below is
included among the examples distributed with KnowledgeWorks, and also in
Appendix B.3, “Uncertain Reasoning Facility”.

In this example, we wish to associate a certainty factor with objects in a manner
similar to the MYCIN system (see Rule-Based Expert Systems, B. G. Buchanan
and E. H. Shortliffe, Addison-Wesley 1984). When we assert an “uncertain”
object we wish it to acquire the certainty factor of the instantiation which is fir-
ing. We define the certainty factor of an instantiation to be the certainty factor
of all the objects making up the instantiation multiplied together. Addition-
ally, we wish rules to have an implication strength associated with them which
is a multiplicative modifier to the certainty factor obtained by newly asserted
uncertain objects. The general approach is as follows:

= Define global variables *c- f act or * to hold the certainty factor of the
current instantiation and *i npl i c- st rengt h* to hold the implication
strength of the rule, and a class of “uncertain” KnowledgeWorks
objects:

(def -kb-cl ass uncertai n- kb-object ()
((c-factor :initform(* *c-factor* *inplic-strength*)
:accessor object-c-factor)))
The uncertain objects should contain this class as a mixin.
= Define a function to obtain the certainty factor of instantiations:

(defun inst-c-factor (inst)
(reduce '* (inst-token inst) :key 'object-c-factor))
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= Define a conflict resolution tactic to prefer either more or less certain
instantiations (See Section 6.1.2, “User-definable Conflict Resolution”
for details).

= Define a meta-rule to set the global certainty factor to the certainty
factor of the instantiation about to fire:

(defrul e uncertain-context :backward
((uncertai n- cont ext)
<- -
(start-cycle)
(instantiation ?inst)
((setqg *c-factor* (inst-c-factor ?inst)))
(fire-rule ?inst)
(cut)
(uncertain-context)))

= Define a function implication-strength which sets the variable *i npl i c-
st rengt h* so that rules may set their implication strength by calling the
action:

((inplication-strength <nunber>))
A rule could be defined similarly to:

(defrule my-rule :forward
(my-cl ass ?obj 1)
(my-cl ass ?obj 2)
-->
((inplication-strength 0.6))
(assert (ny-class ?0bj3)))

where the certainty factor of the new object ?obj 3 will automatically
become:

(* (object-c-factor ?0obj1) (object-c-factor ?0bj2) 0.6)

While this is an extremely simplistic version of uncertain reasoning, it sug-
gests how a more elaborate treatment might be approached.
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6.1.2 User-definable Conflict Resolution

A conflict resolution strategy is a list of conflict resolution tactics. A conflict
resolution tactic is a function which takes as arguments two rule instantia-
tions, and returnst if and only if the first is preferred to the second, otherwise
NI L. A conflict resolution tactic may be defined by

(deftactic <tactic-nane> {<type>} <lanbda-list> [<doc-string]

<body>)
where <t act i c- name> is the name of the tactic and of the function being
defined which implements it, and <l anbda- | i st > is a two argument lambda-
list. <t ype> may be either : stati c or: dynam c, defaulting to : dynamni c. A
dynamic tactic is one which looks into the objects which match the rule to
make up the instantiation; a static one does not. For example, a tactic which
prefers instantiations which match, say, truck objects to instantiations which
do not could be defined as static. However, if it looks into the slot values of the
truck object it should be defined as dynamic. Static tactics are treated more
efficiently but wrongly declaring a tactic as static will lead to incorrect conflict
resolution. If doc-string is given, then it should be a string. The value can be
retrieved by calling the function docunent at i on with doc-type f unct i on.

It is an absolute requirement that there exist no instantiations for which
(<tactic-name> <instantiationl> <instantiation2>)

and
(<tactic-name> <instantiation2> <instantiationl>)

both return t . Consequently, for any single given instantiation
(<tactic-name> <instantiation> <instantiation>)

must returnni | .

The function which defines a conflict resolution tactic should be computation-
ally cheap as it is used repeatedly and frequently to compare many different
pairs of instantiations.

6.1.2.1 Examples

The following tactic prefers instantiations with truck objects to ones without
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(deftactic prefer-trucks :static (instl inst2)
(flet ((truck-p (obj) (typep obj '"truck)))
(and (some # truck-p (inst-token instl))
(notany #' truck-p (inst-token inst2)))))

Note that this tactic would be incorrect if we did not check that the second
instantiation does not refer to any trucks (otherwise it would always return t
if both instantiations contain trucks). It can safely be declared as static as it
does not look into the slots of the objects which make up the instantiation.

This tactic implements alphabetical ordering on rule names:

(deftactic al phabetical -rul ename :static (instl inst2)
(string< (synbol -nanme (inst-rulenanme instl))
(symbol - nanme (inst-rulenanme inst2))))

This tactic prefers instantiations which bind the variable ?x to zero:

(deftactic prefer-?x=0 :dynanmic (instl inst?2)
(flet ((fetch-?x (inst)
(cdr (assoc '?x (inst-bindings inst)))))
(and (eql O (fetch-?x instl))
(not (eql O (fetch-?x inst2))))))

Note that again we must not forget to check that ?x is not zero in the second
instantiation. This tactic must be declared dynamic as ?x must have been
instantiated from the slots of one of the matched objects.

The final tactic is for the example of uncertain reasoning and implements a
method of preferring “more certain” instantiations:

(deftactic certainty :dynamc (instl inst2)
(> (inst-c-factor instl) (inst-c-factor inst2)))

This tactic must be dynamic if the certainty factors of objects can be modified
after creation. If this is forbidden the tactic could be defined as static. Then the
context defined by

(defcontext my-context :strategy (priority certainty))

will prefer instantiations of rules with higher priority or, if this does not dis-
criminate sufficiently, instantiations which are "more certain".
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6.2 Optimization
6.2.1 Forward Chaining

6.2.1.1 KnowledgeWorks Structures

A CLOS class may be replaced by a structure for increased speed when all the
power of CLOS is not needed. Within the rule interpreter the structure
behaves like a CLOS class which:

e Hasaninitformofnil foreach slot
= Has the keyword version of the slot name as initarg for each slot
= Has only single inheritance
= Has no methods defined on it
= Should not be modified from Lisp after its creation.
A KnowledgeWorks structure is defined by the macro
(def -kb-struct <cl ass-spec> <sl ot -spec>*)

where the arguments are the same as for def st ruct except that in <cl ass-
spec> only the options : i ncl ude and : pri nt - functi on are allowed. A struc-
ture may only be included in a KnowledgeWorks structure if it too is a Knowl-
edgeWorks structure defined by def - kb- st ruct . All the functions normally
provided by def st ruct (accessors, a predicate etc.) are generated. An instance
of the structure class may be created by the generic function

(make-i nstance <cl ass-nanme>
{<sl ot - speci fi er> <val ue>}*)

where <sl ot - speci fi er > is the keyword version of the slot name, as with any
structures, and <val ue> is the value the slot is to take, otherwise defaulting to
the value specified in the def - kb- st ruct form. If created from Lisp by any
means other than neke- i nst ance (for example, by the automatically defined
make- <st r uct ur e- nane> constructor), the inference engine will not know
about the structure.

Once created, structures must not be modified directly from Lisp as this will
corrupt the state of the forward chaining inference engine. For example:



6.2 Optimization

(def -kb-struct train position speed)

(def -kb-struct signal position col our)
(rmake-instance "train :position O :speed 80)
(make-instance 'signal :position 10 :colour 'red)

defines KnowledgeWorks structures for trains and signals and makes an
instance of each. Note that they are not fully-fledged CLOS objects but are
analogous to working memory elements in OPS5.

6.2.1.2 Efficient Forward Chaining Rule Preconditions

Forward chaining rules are more efficient if the more restrictive preconditions
(that is, the ones which will have fewer matches) are written first. Computa-
tionally cheap Lisp tests should be used wherever possible as they reduce the
search space of the rule interpreter. The Lisp tests should where possible be
broken into sufficiently small pieces that they can be applied as early on as
possible.

For example, the precondition fragment

(train ?t position ?pl)
(test (> ?pl 5))
(signal ?s position ?p2)
(test (> ?p2 6))

is better than

(train ?t position ?pl)
(signal ?s position ?p2)
(test (and (> ?pl1 5) (> ?p2 5)))

because in the first example the Lisp tests can be applied directly to the trains
and signals respectively before looking at combinations of trains and signals,
whereas in the second case all the combinations must be produced before the
Lisp test can be applied. Simply separating the tests is enough for the rule
compiler to apply them to the right object base matches — the precise order of
the tests is unimportant.
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6.2.2 Conflict Resolution

6.2.2.1 Use of Contexts

The single most significant way to improve conflict resolution time is to
divide the rulebase up into contexts. The time taken by conflict resolution is
dependent on the total number of instantiations of all the rules in the context
so the fewer rules in each context, the more efficient conflict resolution will be.

6.2.2.2 Optimization of the Strategy

A conflict resolution strategy may be optimized by combining the constituent
tactics in a more effective manner. There are three different types of conflict
resolution tactic:

= Rule-defined (meaning the tactic relies only on the rule of the instantia-
tion and on nothing else), including priority, - priority, order, - order,
specificity and-specificity

= Static (meaning the tactic does not look into the slots of the matched
objects which make up the instantiation), including r ecency and -
r ecency, and

= Dynamic (meaning the tactic may look into the objects making up the
instantiation), including nea, - mea, | ex and - | ex.

KnowledgeWorks is best able to optimize rule-defined tactics and least able to
optimize dynamic tactics. The optimizations for a particular type of tactic can
only be applied if it is preceded only by tactics which can be optimized to the
same degree (or better). For example, in the strategy (recency priority),the
tactic pri ori ty would only be optimized as a static tactic. In the strategy
(priority mea recency),priority can be optimized as a rule-defined tactic
but r ecency will be treated as a dynamic tactic.

Some final points to bear in mind:

= Tactics which tend to prefer existing instantiations over newer ones (for
example - mea, -1 ex and - r ecency) will degrade performance

= recency and | ex have similar functionality but r ecency is more effi-
cient.
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6.2.3 Backward Chaining

6.2.3.1 Pattern Matching

The KnowledgeWorks Backward Chainer indexes clauses for a backward rule
based on the first argument. If the first arguments to backward rule clauses
are distinct non-variables, the backward chainer can pre-select possible
matching clauses for a call.

For example, in the following rule:

(defrul e age-of :backward
((age-of charlie 30) <--)
((age-of william 25) <--)
((age-of james 28) <--))
The call: (age- of james ?x) would jump directly to the third clause and bind
?x to 28 without trying the other two.

The call: (age- of t om ?x) would fail immediately without doing any pattern
matching.

Clauses are distinguished first by the types and then the values of their first
arguments.

6.2.3.2 Tail Recursion

The KnowledgeWorks Backward Chainer supports the transformation of
“tail-recursive” calls into jumps. Thus, stack overflow can be avoided without
resorting to “repeat, fail” loops in most cases. For example, given the defini-
tion:

(defrul e run-forever :backward
((run-forever)
<- -
(run-forever)))

the call: (run-forever) will run forever without generating a stack over-
flow. Note that this optimization is not limited to recursive calls to the same
rule. The last call of any rule will be compiled as a jump, drastically reducing
stack usage.
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6.2.3.3 Cut

The use of “cut” is a well known performance enhancement for Prolog-style
rules. In KnowledgeWorks it does more than reduce the time spent in search.
When a “cut” is invoked, all the stack space between the initial call to the con-
taining rule and the current stack location is reclaimed immediately, and can
have a significant impact on the total space requirements of a program.

6.3 Use of Meta-Classes

Objects of meta-classes other than st andar d- cl ass may be made available to
KnowledgeWorks by including the KnowledgeWorks mixin st andar d- kb-
obj ect . This requires

= The existence of aval i dat e- super cl ass method allowing st andar d-
kb- obj ect (meta-class st andar d- cl ass) to be a superclass of the class
being defined with a different meta-class

= That the meta-class in question does not implement any particularly
strange behavior on slot access, for example, if querying a slot value
results in setting it.

6.3.1 Example

A meta-class st andar d- kb- cl ass could be defined as a KnowledgeWorks
class. New KnowledgeWorks classes (or even ordinary non-KnowledgeWorks
classes) could be defined with this meta-class. KnowledgeWorks could then
reason about the instances of the classes and about the class objects them-
selves. The code below implements this:

(def - kb-cl ass standard-kb-cl ass (standard-cl ass) ())
(def met hod val i dat e- super cl ass
((cl ass standard-kb-cl ass)
(supercl ass standard-cl ass))
t)
(def-kb-class foo () ((slot))
(: metacl ass standard-kb-cl ass))

Then when the following rule fires:
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(defrule find-kb-class :forward
(standard- kb-cl ass ? clos::nane ?n)
-->
((format t "~% can reason about class ~s" ?n)))

it will output:

| can reason about class FOO

6.4 Logical Dependencies and Truth Maintenance

When a rule creeates an object that depends on a specific set of preconditions,
it is sometimes necessary to erase that object when those preconditions no
longer hold. This is an example of truth maintainence.

KnowledgeWorks provides a mechanism to track logical dependencies
between objects and preconditions which cause any dependent objects to be
erased automatically. This is achieved using a | ogi cal clause in a forward
chaining rule, with a precondition of the form

(1 ogi cal <forward-condition>+)

The enclosed forward conditions in this clause are matched as normal, but if
the rule fires and creates new objects (by assert or nake- i nst ance) then these
objects are associated with the enclosed conditions. If the conditions are found
to be false in the future, then the created objects are erased automatically (see
er ase, page 98).

NB: There can be at most one | ogi cal clause in a rule (though it can contain
multiple subclauses) and it must be the first clause in the rule. Other clauses
can follow the logical clause, but they are not part of the logical dependency.
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6.4.1 Example
Given the following classes and rules

(def - kb-cl ass nunber-object ()
((value :initarg :value)))

(def - kb-cl ass have-sone-| arge-nunbers ()

0))

(defrul e notice-a-Iarge-nunber :forward
(1 ogical (nunber-object ? value ?val ue)
(test (> ?value 100)))
-->
(assert (have-sone-|arge-nunbers ?)))

then ahave- some- | ar ge- nunber s object will be created when a number larger
than 100 exists:

(setg nl (nake-instance 'nunber-object :value 10))

(infer)

(any ' ?x ' (have-sone-|arge-nunbers ?x)) ==> fal se

(setf (slot-value nl 'value) 200) ; this is large

(infer)

(any ' ?x ' (have-sone-|arge-nunbers ?x)) ==> true
In addition, when the large number becomes smaller, the have- sonme- | ar ge-
nunber s object will be erased again:

(setf (slot-value nl 'value) 55)
(infer)
(any ' ?x ' (have-sone-| arge-nunbers ?x)) ==> fal se

because a logical dependency was tracked between the preconditions

(nunber -obj ect ? val ue ?val ue)
(test (> ?value 100)

and the have- sone- | ar ge- nunber s object.

6.5 Inferencing States

An inferencing state represents all the state needed to run the forward chaining
interpreter, including the object base, the current cycle number and the set of
unfired instantiations. It does not include rule or context definitions or any
backward chaining state information.
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6.5.1 Creating and Maintaining Inferencing States

Inferencing states are first-class objects that can be created and destroyed as
required. Each inferencing state must have a unique name (as compared with
eql ) and initially there is a single inferencing state named : def aul t.

The function make- i nf er enci ng- st at e makes a new empty inferencing state.
Inferencing states must be destroyed with dest r oy- i nf er enci ng- st at e when
no longer needed, to release the memory that they use.

Inferencing states can be found using the function fi nd-i nf erenci ng- st ate
and the function | i st - al | -i nf er enci ng- st at es can be used to make a list of
all known inferencing states.

6.5.2 The Current Inferencing State

The value of the variable *i nf er enci ng- st at e* is known as the current infer-
encing state. Its value can be changed before calling KnowledgeWorks func-
tions, but should not be changed within the body of a rule.

Some operations, such as object creation, slot modification, reset and i nf er
only affect the current inferencing state. Backward chaining operations that
match the object base only find objects from the current inferencing state.

Operations that change rules or contexts, such as defrul e and cl ear-al |,
affect all inferencing states.

6.5.3 Uses of Inferencing States

In many cases, a single inferencing state is sufficient and the initial inferencing
state named : def aul t can be used without any special effort.

To allow several independent inferencing operations to be performed simulta-
neously, multiple inferencing states must be managed explicitly. Some typical
situations are described below.

6.5.3.1 Multiple threads

By binding *i nf er enci ng- st at e* around all KnowledgeWorks operations in
a thread’s main function as in the example below, its value can be unique to
each thread.
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(defun test-1-counter (nane)
(let* ((*inferencing-state* nil)
(step (1+ (random 10)))
(limt (* step (+ 2000 (random 100)))))
(unwi nd- pr ot ect
(progn
(setqg *inferencing-state*
(make-i nferenci ng-state name))
(make-instance ' counter
cvalue limt

:step step)
(infer))
(destroy-inferencing-state *inferencing-state*))))
(rmp: process-run-function (format nil "Test ~D' index)
()
"test-1-counter
(gensym

6.5.3.2 Interleaved in a Single Thread

By binding *i nf er enci ng- st at e* around specific KnowledgeWorks opera-
tions in a function as in the example below, multiple inferencing states can be
maintaining within a single thread.

(defun test-stepping-single-context ()
(let ((statel (make-inferencing-state 'statel))
(state2 (make-inferencing-state 'state2)))
(unwi nd- pr ot ect
(progn
(let ((*inferencing-state* statel))
(make-instance 'step-controller
: kb-nane ' stepper-one-a))
(let ((*inferencing-state* state2))
(make-instance 'step-controller
: kb-nane ' stepper-one-b))
(l oop repeat 10
do
(let ((*inferencing-state* statel))
(infer))
(let ((*inferencing-state* state2))
(infer))))
(destroy-inferencing-state statel)
(destroy-inferencing-state state2))))
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The symbols documented in the following pages are all external in the KW
package unless stated otherwise. They are listed in alphabetical order.

all-debug Function
Summary Turns debugging facilities on.
Signature al | - debug

Description Turns on all KnowledgeWorks debugging facilities. This
means that rules and contexts can be single stepped and
monitored, and a record is kept of whenever objects are cre-
ated or modified.

This should be called before compiling any rules or contexts
that are to be debugged.

Examples (al | - debug)

See also no- debug

85



7 Reference Guide

any

Summary
Signature

Arguments

Values

Description

Examples

See also

assert

Summary

86

Function

Return the first match of a backward chaining goal.
any pattern-to-instantiate goal-to-prove => result, successp

pattern-to-instantiate
A list or symbol.

goal-to-prove Any backward chaining goal.

result ni | or a value matching pattern-to-instantiate

successp A boolean.

The backward chaining inference engine is started to look for
any set of bindings which satisfy goal-to-prove. Using those
bindings, pattern-to-instantiate is instantiated and returned.

Two values are returned. The second value indicates with t
that a proof was found, or with ni | that no proof exists. In

the former case, the first value is the instantiated version of
pattern-to-instantiate, in the latter case, the first value is ni | .

Any subgoals that match the object base will only find objects
from the current inferencing state.

(any '"(?x isin (12 3)) '(menber ?x (1 2 3)))
returns(1 ISIN (122 3)), T
(any '(?truck is a truck) ' (truck ?truck))

returns (#<TRUCK TRUCK5> |S A TRUCK), T

findall

Backward Chaining Goal

Creates or modifies objects in the object base.



Signature

Arguments

Description

Examples

See also

clear-all

Summary

Signature

assert (class-name variable {slot-name term}*)

class-name The name of a class.

variable A variable beginning with 2.
slot-name The name of a slot in the class-name.
term An expression.

The class-name must be the name of a class of objects known
to KnowledgeWorks. Each term is an expression composed of
Lisp data structures and KnowledgeWorks variables.

If variable is unbound a new instance of class-name is created
with each named slot-name initialized to the value of the cor-
responding term.

If variable is bound, that bound instance has its named slots
modified to contain the values of the term corresponding to
each slot-name. It is an error if the bound obiject is not of the
named class.

It is an error to put an unbound variable into a slot of an
object in the object base.

Only objects in the current inferencing state will be affected.

(assert (truck ?truck driver 2driver))
(assert (possible-trucks ? trucks (?truck . ?trucks))

erase

Function

Clears all contexts, rules and objects.

clear-all
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Description

Examples

See also

clear-rules

Summary
Signature

Description

Examples

See also

conflict-set

Summary

Signature
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The function cl ear - al | clears all contexts, rules and objects.
The list of KnowledgeWorks classes remains unaffected. The
default context def aul t - cont ext is not removed, but all
rules in it are.

The function affects all inferencing states.
(clear-all)

clear-rul es
reset

Function
Clears all contexts and rules.
clear-rul es

The function cl ear - r ul es clears contexts and rules. The list
of KnowledgeWorks classes and the object base remains
unaffected. The default context def aul t - cont ext is not
removed, but all rules in it are.

This function affects all inferencing states.
(clear-rules)

cl ear-al
reset

Backward Chaining Goal

Finds the current meta-interpreter rule instantiations.

conflict-set variable



Arguments

Description

Examples

See also

context

Summary
Signature
Arguments

Description

Examples

See also

variable An unbound KnowledgeWorks variable
introduced by 2.

This backward chaining goal is only relevant when writing a
meta-interpreter for a context. It binds variable to the list of all
existing rule instantiations in the currently executing context.
This list is in the order preferred by the conflict resolution
strategy for the context.

(conflict-set ?conflict-set)

instantiation
fire-rule

Backward Chaining Goal

Adds new contexts to the agenda.
cont ext context-list
context-list A list of context names.

The given list of contexts in context-list is placed on top of the
agenda (the context stack). The current context is not
changed. It is an error if the named contexts do not exist.

If context-list contains variables, then they must be already
bound.

(context (ny-context))
(context (?x ?y)) ; if ?x ?y bound to context nanes

return
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current-cycle

Summary
Signature
Values

Description

See also

cut

Summary
Signature

Description

Examples

Function

Returns the current forward chaining cycle number.
current-cycl e => cycle-number
cycle-number An integer.

Returns the current cycle number of the forward chaining
rule interpreter in the current inferencing state. If the forward
chaining rule interpreter is not running, then it returns the
total number of cycles executed by the forward chaining rule
interpreter the last time it ran. If the forward chaining rule
interpreter has not run at all, then it return zero.

*i nf er enci ng- st at e*

Backward Chaining Goal

The standard prolog predicate that stops backtracking.
cut

cut is a standard prolog predicate. When first called it
succeeds and freezes certain choices made by the backward
chainer up to this point. It may no longer attempt to resatisfy
any of the goals between the start of clause and the cut , and
it may not attempt to use any other clauses to satisfy the
same goal.

(defrul e nice :backward
((nice ?x)
<- -
(rottweiler ?x)
(cut)
(fail))

((nice ?x) <--))



See also

*cycle*
Summary

Description

See also

def-kb-class

Summary

Signature

Arguments
Values

Description

implements “everything is nice unless it is a rottweiler”. First
the backward chainer will attempt to prove (ni ce fi do)
with the first clause. If fi do is a rottweiler the cut then pre-
vents the backward chainer from using the second clause
which says “everything is nice”. The fail ensures that (ni ce
fido) fails.

fail

Symbol Macro

Deprecated.

Deprecated. New code should use current -cycl e.

Prior to LispWorks 5.0, *cycl e* was a variable.

current-cycle

Macro

Defines a class for use in the object base.

def - kb- cl ass class-name superclass-list slot-descriptions &r est
options => class

The arguments are identical to those for def cl ass.
class the named class object

Defines a new CLOS class as def cl ass does. However, if
none of the given superclasses is a subclass of st andar d- kb-
obj ect , then st andar d- kb- obj ect is added to the list of
superclasses.
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Examples

See also

def-kb-struct

(def-kb-class vehicle () ((driver :initarg :driver)))
(def -kb-cl ass truck (vehicle)
((l oad :accessor truck-1oad)))

def - naned- kb- cl ass
def - kb- struct

Macro

Summary Defines a structure class for use in the object base.

Signature def - kb- st ruct name-and-options {slot-description}* => name

Arguments The arguments are as for def st ruct, except that in name-and-
options the only valid options are : i ncl ude and : pri nt -
function.

Values name The name of the structure class.

Description Defines a KnowledgeWorks structure class. Objects of these
classes are analogous to Lisp structures except that they may
be used in rules similarly to CLOS objects.

Examples (def - kb-struct start)

(def -kb-struct (named-kb-struct
(:print-function print-naned-kb-struct))
(nane (gensym ' naned- kb-struct)))
(def - kb-struct (possible-trucks-for-I|oad
(:include named-kb-struct))
| oad trucks)
See also def - kb-cl ass
def-named-kb-class Macro
Summary Defines a class of named objects for use in the object base.



Signature

Arguments
Values

Description

Examples

See also

defcontext

Summary

Signature

Arguments

def - naned- kb- cl ass class-name superclass-list slot-descriptions
&r est options => class

The arguments are identical to those for def cl ass.
class the named class object

Defines a new CLOS class as def cl ass does. However, if
none of the given superclasses is a subclass of named- kb-

obj ect , then naned- kb- obj ect is added to the list of super-
classes. The class inherits a name slot kb- nane of which the
initialization form (. i ni t f or m) generates a symbol from the
class name using (gent enp class-name) .

(def - naned- kb-cl ass vehicle ()
((driver :initarg :driver)))

(def - naned- kb-cl ass truck (vehicle)
((load :accessor truck-1oad)))

def - kb-cl ass
def - kb- st ruct
get - kb- obj ect
kb- name

naned- kb- obj ect

Macro

Defines a context.

def cont ext context-name &key (refractoriness t) (.auto-return t)
strategy meta documentation

context-name The name of the context being defined.
refractoriness A boolean.
auto-return A boolean.

strategy A list of symbols.
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Description

Examples

See also

meta A list of actions.

documentation A string.

Defines a context named context-name. If a context of that
name already exists then it, and all the rules in it, are first
removed.

If refractoriness is ni | then a rule instantiation remains eligible
to fire again after firing once. If refractoriness ist (the default)
then each rule instantiation will only fire once.

The auto-return indicates, when there are no more rules to be
fired in the context, whether to signal an error or simply to
pass control to the next context on the agenda. The default
value t passes control on without an error.

The strategy is the conflict resolution strategy for the context,
consisting of a list of tactic names.

The meta is a list of actions which make up the optional meta-
interpreter for the context.

If documentation is given, then it should be a string. The value
can be retrieved by calling the function docunent at i on with
doc-type cont ext .

(defcontext my-context :strategy (priority recency))
(def cont ext another-context :strategy (order)
:meta ((start-cycle)
(instantiation ?inst)
(fire-rule)
(cut)
(anot her-context)))

st andar d- cont ext
-l ex

| ex

- nea

nmea

-order

or der



defrule

Summary
Signature

Arguments

Values

Description

-priority
priority
-recency
recency
-specificity
specificity

Macro

Defines a rule.

defrul e rule-name direction [doc-string] & est body => rule-name

rule-name A symbol.

direction Either : f orwar d or : backwar d.
doc-string An optional string.

body Forms as described in Chapter 3, Rules.
rule-name A symbol.

Defines a rule named rule-name (which must be distinct from
any other rule name, context name or KnowledgeWorks class
name). If direction is : f or war d a forward chaining rule is
defined, if : backwar d a backward chaining rule is defined. If
doc-string is given, then it should be a string. The value can be
retrieved by calling the function document at i on with doc-
typerul e.

A full description is given in Chapter 3, Rules.
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deftactic

Summary

Signature

Arguments

Values

Description
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(defrule nmove-train :forward :context trains
(train ?train position ?train-pos)
(signal ?signal position ?signal-pos col our green)
(test (= ?signal-pos (1+ ?train-pos)))
-->
((format t "~%rain noving to ~S" ?signal - pos))
(assert (signal ?signal colour red))
(assert (train ?train position ?signal-pos)))
(defrule link-exists :backward
((link-exists ?townl ?town2)
<- -
(or (link ?link townl ?townl town2 ?town2)
(link ?link town2 ?townl townl ?town2))

(cut))
((link-exists ?townl ?town2)
<- -

(route-exists ?townl ?town2)))

Macro

Defines a tactic function for use in context strategies.

deftacti c tactic-name type lambda-list &ody body => tactic-
name

tactic-name A symbol.

type Either :static or :dynamic.
lambda-list A two argument lambda-list.
body A function body.

tactic-name A symbol.

Defines a new conflict resolution tactic named tactic-name.
The type of the tactic may be : st ati ¢ if the body does not
look into the slots of the objects making up the instantiation,
otherwise : dynamni c. The lambda-list binds to two instantia-
tion objects and the function body body should return non-



ni | if and only if the first instantiation object is preferred to
the second. def t act i ¢ also defines a function of the same
and body can be preceded by a documentation string.

The newly defined tactic may be used as any in-built tactic.

Examples (deftactic prefer-trucks :static (instl inst2)
(flet ((truck-p (obj) (typep obj "truck)))
(and (some #' truck-p (inst-token instl))
(notany # truck-p (inst-token inst2)))))
The new tactic may be used in a def cont ext form:
(defcontext my-context :strategy (prefer-trucks))
See also i nst - bi ndi ngs
i nst -token
i nst-rul enane
def cont ext
destroy-inferencing-state Function
Summary Destroys an inferencing state.
Signature destroy-i nferenci ng-state name-or-state
Arguments name-or-state  Any object.
Description Destroys an inferencing state named by name-or-state.
If name-or-state is and inferencing state, then it is destroyed.
Otherwise, any inferencing state with that name (as com-
pared using eql ) is destroyed.
It is an error to destroy the current inferencing state.
Examples (destroy-inferencing-state 'ny-state)
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See also

erase

Summary
Signature
Arguments

Description

Examples

See also

fail
Summary
Signature

Description
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find-inferencing-state

*i nf er enci ng- st at e*

i nf erenci ng- st at e- nane
list-all-inferencing-states
make- i nf erenci ng-state

Backward Chaining Goal
Erases an object from the object base.
erase variable

variable A a KnowledgeWorks obiject.

The variable must be bound to a KnowledgeWorks CLOS
object or a KnowledgeWorks structure.

The given object is removed from the object base of the cur-
rent inferencing state.

(erase ?x) ; 7?x bound to an object

assert

Backward Chaining Goal

The standard prolog predicate that always fails.
fail

This goal always fails. It is sometimes used with cut.



Examples

(defrul e nice :backward
((nice ?x)
<- -
(rottweiler ?x)
(cut)
(fail))

((nice ?x) <--))

implements “everything is nice unless it is a rottweiler”.

See also cut
find-inferencing-state Function
Summary Finds a known inferencing state.
Signature find-inferencing-state name &key if-does-not-exist => state
Arguments name Any object.
if-does-not-exist Either : error or:create.
Values state An inferencing state.
Description Finds and returns an inferencing state named by name.
If an inferencing state with the same name already exists (as
compared using eql ), it is returned.
Otherwise, the value of if-does-not-exist determines what hap-
pens:
serror A continuable error is signaled. Invoking the
cont i nue restart creates and returns a new
inferencing state.
:create A new inferencing state is created and
returned.
Examples (find-inferencing-state 'ny-state)
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See also

findall

Summary
Signature

Arguments

Values

Description

Examples
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destroy-inferencing-state
*i nf er enci ng- st at e*

i nf erenci ng- st at e- nane
list-all-inferencing-states
make- i nf erenci ng-state

Function

Return all matches of a backward chaining goal.
findall pattern-to-instantiate goal-to-prove => list

pattern-to-instantiate
A list or symbol.

goal-to-prove Any backward chaining goal.
list A list

The backward chaining inference engine is started to look for
all sets of bindings which satisfy goal-to-prove. For each of
those bindings, pattern-to-instantiate is instantiated and col-
lected to return a list. The value is nil if nothing goal-to-prove
cannot be satisfied.

Any subgoals that match the object base will only find objects
from the current inferencing state.

(findall "(?x is in (12 3)) '(nmenber ?x (1 2 3)))
returns

((L1SIN(1 2 3))
(2 1SIN (1 2 3))
(31SIN (12 3)))

(findall ' (?truck is a truck) '(truck ?truck))

returns



See also

fire-rule

Summary
Signature
Arguments

Description

Examples

See also

get-kb-object
Summary
Signature
Arguments

Values

((#<TRUCK TRUCK1> |'S A TRUCK)
(#<TRUCK TRUCK2> IS A TRUCK))

any

Backward Chaining Goal
.Fires the given meta-interpreter rule instantiation.
fire-rul e instantiation
instantiation An instantiation object.
This backward chaining goal is only relevant when writing a
meta-interpreter for a context. It fires the given rule instantia-

tion. It is an error if the passed object is not an instantiation
object.

(fire-rule ?instantiation)
start-cycle
instantiation

def cont ext
st andar d- cont ext

Function

Finds a named obiject in the object base.
get - kb- obj ect object-name => object
object-name A symbol.

object A KnowledgeWorks CLOS obiject.
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Description

Examples

See also

*In-interpreter*

Summary

Description

Initial Value

infer

Summary
Signature
Arguments

Values

Returns the KnowledgeWorks object named object-name in
the object base of the current inferencing state. If there is no
such object an error results.

Classes of named objects can be defined using the macro
def - nanmed- kb- cl ass.

(get - kb-obj ect 'fred)

def - naned- kb- cl ass
kb- name

Variable

Allows code to detect when it is running in a rule.

The variable is bound to t if the code executing has been
called (directly or indirectly) from the forward chaining rule
interpreter. Otherwise it bound to ni | . The value should not
be changed.

nil

Function

Runs the forward chaining inferencing engine.
i nfer &ey (contexts ' (default-context)) => cycle-count
contexts A list of context names.

cycle-count An integer.



Description

Runs the forward chaining inference engine in the current
inferencing state, with contexts as the initial agenda. The first
rules to fire will be from the first context listed in contexts
until control is passed on.

The value returned as cycle-count is the total number of cycles
executed (given in current-cycl e).

Examples (infer :contexts '(my-context another-context))
See also current-cycle
*inferencing-state* Variable
Summary The current inferencing state.
Description The value of *i nf er enci ng- st at e* is the current inferencing
state for many KnowledgeWorks functions.
This variable can be bound to a particular inferencing state
before calling other KnowledgeWorks functions, but should
not be changed within the body of a rule.
Initial Value An empty inferencing state named : def aul t .
See also current-cycle
destroy-inferencing-state
find-inferencing-state
i nf erenci ng- st at e- nane
list-all-inferencing-states
make- i nf erenci ng-state
inferencing-state-name Function
Summary Returns the name of an inferencing state.
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Signature
Arguments
Values
Description
Examples

See also

inst-bindings
Summary
Signature
Arguments
Values

Description

Example

i nf erenci ng- st at e-nane state => name

state An inferencing state.

name Any object.

Returns the name of the given inferencing state.
(i nferenci ng-state-nane *inferencing-state*)

find-inferencing-state

*i nf er enci ng- st at e*
list-all-inferencing-states
make-i nf erenci ng-state

Function

Returns the bindings in a rule instantiation.
i nst - bi ndi ngs instantiation => bindings
instantiation An instantiation object.
bindings An association list.

Returns an association list of the variables and their bindings
in the instantiation. The variables are those produced by the
condition part of the forward chaining rule.

For an instantiation of a rule with the precondition

(object ? color ?color-value size ?size)

the value returned by

(i nst-bindings inst)

might be



See also

inst-rulename

Summary
Signature
Arguments
Values

Description

See also

inst-token

Summary
Signature

Arguments

((?color-value . :red) (7?size . 20))

conflict-set
deftactic

i nst-rul enane
i nst -token
instantiation

Function
Returns the rule name of a rule instantiation.
i nst-rul enanme instantiation => rulename
instantiation An instantiation obiject.
rulename A symbol which is the name of a rule.

Returns the rule name of the instantiation (the name of the
rule of which this is an instantiation).

conflict-set
i nst - bi ndi ngs
deftactic

i nst -t oken
instantiation

Function

Returns the token of a rule instantiation.
i nst -t oken instantiation => token

instantiation An instantiation obiject.
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Values

Description

See also

instantiation

Summary
Signature
Arguments

Description

Examples

token A list of objects.

Returns the token of the instantiation. The token is the list of
objects that match the condition part of the forward chaining
rule. This list of objects is in reverse order to the order in
which the conditions appear in the rule. For example, if the
forward chaining conditions are

(train ?train)
(signal ?signal)

then the token will have the form ( signal-object train-object) .
conflict-set

deftactic

i nst-rul enane

i nst - bi ndi ngs
instantiation

Backward Chaining Goal

Find the next meta-interpreter rule instantiation that will fire.
i nstantiation variable
variable An unbound variable introduced by 2.

This backward chaining goal is only relevant when writing a
meta-interpreter for a context. It binds variable to the next pre-
ferred instantiation from the conflict set of the currently exe-

cuting context.

This goal may be satisfied repeatedly each time returning the
next instantiation. When no instantiations are left, it fails.

(instantiation ?instantiation)



See also

conflict-set

i nst - bi ndi ngs

i nst-rul enane

i nst -token
start-cycle
fire-rule

def cont ext

st andar d- cont ext

list-all-inferencing-states Function

Summary Returns a list of all the known inferencing states.

Signature list-all-inferencing-state => states

Values states A list of inferencing states.

Description Returns a list of all the known inferencing states. Inferencing
states become known when they are make and are known
until they are destroyed.

Examples (I'ist-all-inferencing-states)

See also destroy-inferencing-state
find-inferencing-state
*i nf er enci ng- st at e*

i nf erenci ng- st at e- nane
make- i nf erenci ng-state
kb-name Generic Function
Summary Returns the name of an object.
Signature kb- name object => name
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Arguments
Values

Description

Examples

See also

kw-class

Summary
Signature
Arguments

Description

Examples

See also

object A KnowledgeWorks named CLOS object
name A symbol.

Returns the name of object. It is an error if the object is not a
named object. Classes of named objects can be defined using
the macro def - named- kb- cl ass.

(kb-nanme (get-kb-object 'fred)) ; returns FRED
def - nanmed- kb- cl ass

get - kb- obj ect
naned- kb- obj ect

Backward Chaining Goal

Matches all KnowledgeWorks class names.
kw cl ass term
term Any backward chaining term.

This goal can act as a generator and is resatisfiable. It suc-
ceeds when term is a symbol which is the name of a Knowl-
edgeWorks class. If term is an unbound variable it generates
the names of the KnowledgeWorks classes.

(kw-class truck) ; succeeds if truck is a KWcl ass

(kw-cl ass ?cl ass)
; ?class is bound to the nane of a KWcl ass

def - kb-cl ass
def - kb-struct
def - naned- kb- cl ass



-lex Conflict Resolution Tactic / Function

Summary Implements the - | ex tactic.
Signature -1 ex instantiationl instantiation2 => boolean
Arguments instantiationl  An instantiation object.

instantiation2 ~ An instantiation object.
Values boolean Either ni | or non-ni | .

Description The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic
-I ex, otherwise ni | . The function is intended to be used pri-
marily by including it in the conflict resolution strategy for a
context.

Examples (defcontext my-contextl :strategy (-lex))
(defcontext my-context2 :strategy (priority -1ex))

See also def cont ext
deftactic
| ex
instantiation
conflict-set

fire-rule
lex Conflict Resolution Tactic / Function
Summary Implements the | ex tactic.
Signature | ex instantiationl instantiation2 => boolean
Arguments instantiationl  An instantiation object.

instantiation2 ~ An instantiation object.
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Values boolean Either ni | or non-ni | .

Description The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic | ex,
otherwise ni | . The function is intended to be used primarily
by including it in the conflict resolution strategy for a context.

Exanuﬂes (defcontext my-contextl :strategy (lex))

(def context my-context2 :strategy (priority lex))

See also def cont ext
deftactic
-l ex
instantiation
conflict-set
fire-rule

make-inferencing-state Function

Summary Makes a new inferencing state.

Signature make- i nf erenci ng- st at e name &key set-current-p if-exists =>
state

Arguments name Any object.
set-current-p A boolean
if-exists Either : error, : supersede or : overwite.

Values state An inferencing state.

Description Returns an inferencing state named by name.

If an inferencing state with the same name already exists (as
compared using eql ), then the value of if-exists determines
what happens:



Examples

See also

make-instance

Summary
Signature

Arguments

Arguments

Description

serror A continuable error is signaled. Invoking the
cont i nue restart causes the existing infer-
encing state to be returned.

: super sede The existing inferencing state is destroyed
and a new one is returned.

coverwite The existing inferencing state is returned.
If set-current-p is non-nil, then *i nf er enci ng- st at e* is set to
new inferencing state.

(rmake-inferencing-state 'ny-state)

destroy-inferencing-state
find-inferencing-state

*i nf er enci ng- st at e*

i nf erenci ng- st at e- nane
list-all-inferencing-states

Generic Function

Makes a CLOS or KnowledgeWorks structure object.

make-i nstance class & est initargs => object

class A class object or a symbol.
initargs Initialization arguments for the object.
object A new instance of class.

A new instance of the class class is made. The class may be
either a CLOS class or a KnowledgeWorks structure class, in
which case the initargs are the same as those for the automati-
cally defined constructor function of the structure.

The object is added to the object base of the current inferenc-
ing state.
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Examples

See also

-mea

Summary
Signature

Arguments

Values

Description

Examples

See also

(rmake-instance 'start)
(make-instance "driver :location 'london
:kb-nanme 'fred)

def - kb-cl ass
def - kb- struct
def - naned- kb- cl ass

Conflict Resolution Tactic / Function

Implements the - nmea tactic.
- nea instantiationl instantiation2 => boolean

instantiationl  An instantiation object.

instantiation2  An instantiation object.
boolean Either ni | or non-ni | .

The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic

- mea, otherwise ni | . The function is intended to be used pri-
marily by including it in the conflict resolution strategy for a
context.

(defcontext my-contextl :strategy (-nea))
(defcontext my-context2 :strategy (priority -mea))

def cont ext
deftactic

nea
instantiation
conflict-set
fire-rule



mea Conflict Resolution Tactic / Function

Summary Implements the nea tactic.

Signature mea instantiationl instantiation2 => boolean

Arguments instantiationl  An instantiation object.
instantiation2  An instantiation object.

Values boolean Either ni | or non-ni | .

Description The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic nea,
otherwise ni | . The function is intended to be used primarily
by including it in the conflict resolution strategy for a context.

Examples (defcontext my-contextl :strategy (nea))

(defcontext my-context2 :strategy (priority nea))

See also def cont ext
deftactic
- Nea
instantiation
conflict-set
fire-rule

named-kb-object Class

Summary A class that provides named objects.

Superclasses st andar d- kb- obj ect

Initargs : kb- name The name of the object. The default is com-

puted by calling gent enp with the name of
the class.
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Description

Examples

See also

no-debug

Summary
Signature

Description

Examples

See also

not

Summary
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This class is the mixin class for named KnowledgeWorks
CLOS objects.

Subclasses of naned- kb- cl ass are typically defined using the
macro def - nanmed- kb- cl ass.

(defclass driver (named-kb-object)
((location) (allocated-truck)))

get - kb- obj ect
kb- name

def - nanmed- kb- cl ass
st andar d- kb- obj ect

Function

Turns debugging facilities off.
no- debug

Turns off all KnowledgeWorks debugging facilities. This
means that rules and contexts cannot be single stepped or
monitored, and no record is kept of when objects are created
or modified. Execution speed of the rulebase is improved,
and memory requirements reduced.

This should be called before compiling any rules or contexts
that are to be optimized.

(no-debug)

al | - debug

Backward Chaining Goal

A goal that is satisfied when another goal fails.



Signature
Arguments

Description

Examples

See also

-order

Summary
Signature

Arguments

Values

Description

not {condition}*
condition Any backward chaining goal.

If not is used in a backward chaining goal, it succeeds if the
condition contained within it fails. In this usage, only one con-
dition is allowed.

If not is used in a forward chaining pre-condition, it succeeds
if any of the condition contained within it fail. In this usage,
the conditions may only contain expressions normally
allowed in forward chaining pre-conditions (object base ref-
erences and lisp tests).

(not (truck ?truck driver ?driver) (test ?driver))

t est

Conflict Resolution Tactic / Function

Implements the - or der tactic.
-order instantiationl instantiation2 => boolean

instantiationl  An instantiation object.

instantiation2  An instantiation object.
boolean Either ni | or non-ni | .

The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic
-order, otherwise ni | . The function is intended to be used
primarily by including it in the conflict resolution strategy for
a context.
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Exanuﬂes (defcontext my-contextl :strategy (-order))
(defcontext my-context2 :strategy (priority -order))
See also def cont ext
deftactic
or der

instantiation
conflict-set

fire-rule
order Conflict Resolution Tactic / Function
Summary Implements the or der tactic.
Signature order instantiationl instantiation2 => boolean
Arguments instantiationl  An instantiation object.

instantiation2  An instantiation object.
Values boolean Either ni | or non-ni | .

Description The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic
or der, otherwise ni | . The function is intended to be used pri-
marily by including it in the conflict resolution strategy for a
context.

Exanuﬂes (defcontext my-contextl :strategy (order))
(defcontext my-context2 :strategy (priority order))

See also def cont ext
deftactic
-order
instantiation
conflict-set
fire-rule
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*print-verbose* Variable

Summary

Description

Initial Value

-priority
Summary
Signature

Arguments

Values

Description

Examples

See also

Controls how much information is printed for an object.

Normally objects in KnowledgeWorks are printed out in a
brief form similar to ordinary CLOS objects. If this variable is
settot then all the slots and slot values are shown in its
printed representation. Note that circularities cannot be
detected.

nil

Conflict Resolution Tactic / Function

Implements the - pri ori ty tactic.
-priority instantiationl instantiation2 => boolean

instantiationl  An instantiation object.

instantiation2  An instantiation object.
boolean Either ni | or non-ni | .

The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic -
-priority, otherwise ni | . The function is intended to be
used primarily by including it in the conflict resolution strat-
eqgy for a context.

(defcontext my-contextl :strategy (-priority))
(defcontext my-context2 :strategy (recency -priority))

def cont ext
deftactic
priority
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priority
Summary
Signature

Arguments

Values

Description

Examples

See also

-recency

Summary
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instantiation
conflict-set
fire-rule

Conflict Resolution Tactic / Function

Implements the pri ori ty tactic.
priority instantiationl instantiation2 => boolean

instantiationl  An instantiation object.

instantiation2  An instantiation object.
boolean Either ni | or non-ni | .

The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic
priority, otherwise ni | . The function is intended to be used
primarily by including it in the conflict resolution strategy for
a context.

(defcontext my-contextl :strategy (priority))
(defcontext my-context2 :strategy (recency priority))

def cont ext
deftactic
-priority
instantiation
conflict-set
fire-rule

Conflict Resolution Tactic / Function

Implements the - r ecency tactic.



Signature

Arguments

Values

Description

Examples

See also

recency

Summary
Signature

Arguments

Values

recency instantiationl instantiation2 => boolean

instantiationl  An instantiation object.

instantiation2  An instantiation object.
boolean Either ni | or non-ni | .

The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic
-recency, otherwise ni | . The function is intended to be used
primarily by including it in the conflict resolution strategy for
a context.

(defcontext my-contextl :strategy (recency))
(defcontext my-context2 :strategy (priority recency))

def cont ext
deftactic
recency
instantiation
conflict-set
fire-rule

Conflict Resolution Tactic / Function
Implements the r ecency tactic.
recency instantiationl instantiation2 => boolean

instantiationl  An instantiation object.

instantiation2  An instantiation object.

boolean Either ni | or non-ni | .
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Description

Examples

See also

reset

Summary
Signature

Description

Examples

See also

120

The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic

r ecency, otherwise ni | . The function is intended to be used
primarily by including it in the conflict resolution strategy for
a context.

(defcontext my-contextl :strategy (recency))
(defcontext my-context2 :strategy (priority recency))

def cont ext
deftactic
-recency
instantiation
conflict-set
fire-rule

Function
Clears all objects from the object base.
reset

Clears all KnowledgeWorks objects (both KnowledgeWorks
CLOS objects and KnowledgeWorks structures) from the
object base of the current inferencing state.

The list of KnowledgeWorks classes remains unaffected.

(reset)

cl ear-al

clear-rul es



return Backward Chaining Goal

Summary Removes the top-most context from the agenda.

Signature return

Description Takes the topmost context on the agenda and makes it the
current context, discarding the previous current context.
When called from within a rule, rule execution continues to
the end and the next rule to fire will be from the new current
context.

Examples (return)

See also cont ext

*signal-kb-name-clash* Special Variable

Summary Controls the behavior if name clashes occur in object creation.

Description Determines behavior when creating a new named KB object
with the same name as an existing KB object.
The possible values are:
serror Signals a error Continuing will replace the

old object with the new object.
war n Signals a warning and replaces the old
object with the new object.

:qui et Replaces the old object with the new object.

Initial Value cerror.
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-specificity
Summary
Signature

Arguments

Values

Description

Examples

See also

specificity
Summary
Signature

Arguments

122

Conflict Resolution Tactic / Function

Implements the - speci fi ci ty tactic.
-speci ficity instantiationl instantiation2 => boolean

instantiationl  An instantiation object.

instantiation2  An instantiation object.
boolean Either ni | or non-ni | .

The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic -
speci fici ty, otherwise ni | . The function is intended to be
used primarily by including it in the conflict resolution strat-
egy for a context.

(defcontext my-contextl :strategy (-specificity))
(def cont ext mny-context2
:strategy (priority -specificity))

def cont ext
deftactic
specificity
instantiation
conflict-set
fire-rule

Conflict Resolution Tactic / Function
Implements the speci fi ci ty tactic.
speci ficity instantiationl instantiation2 => boolean

instantiationl  An instantiation object.

instantiation2 ~ An instantiation object.



Values

boolean Either ni | or non-ni | .

Description The function returns non-ni | if and only if instantiationl is
preferred to instantiation2 by the conflict resolution tactic
speci fici ty, otherwise ni | . The function is intended to be
used primarily by including it in the conflict resolution strat-
egy for a context.

Exanuﬂes (defcontext my-contextl :strategy (specificity))

(def context my-context2
:strategy (priority specificity))

See also def cont ext
deftactic
-specificity
instantiation
conflict-set
fire-rule

standard-context Backward Chaining Goal

Summary The standard meta-interpreter context.

Signature st andar d- cont ext

Description A built-in backward chaining goal which implements a meta-

interpreter for the default (normal) behavior of a context. It is
as if defined by the rule

(defrul e standard-context :backward
((standard-cont ext)
<- -
(start-cycle)
(instantiation ?instantiation)
(fire-rule ?instantiation)
(cut)
(standard-context)))
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Examples (def cont ext my- cont ext 1
cnmeta (((format t "~%Entering context My-CONTEXT1"))
(standard-context)))

See also def cont ext
start-cycle
instantiation

fire-rule
standard-kb-object Class
Summary A class of objects for use in the object base.

Superclasses st andar d- obj ect

Description This class is the mixin class for (unnamed) KnowledgeWorks
CLOS objects.
Subclasses of st andar d- kb- cl ass are typically defined using

the macro def - kb- cl ass.

Exanuﬂes (defclass driver (standard-kb-object)
((location) (allocated-truck)))

See also def - kb-cl ass
naned- kb- obj ect

start-cycle Backward Chaining Goal
Summary Used in the meta-interpreter to start the cycle.
Signature start-cycle
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Example

See also

start-kw

Summary
Signature

Description

Examples

test

Signature
Arguments

Description

This backward chaining goal is only relevant when writing a
meta-interpreter for a context. This goal must be called at the
start of every forward chaining cycle as it performs some
essential housekeeping.

(start-cycle)
fire-rule
instantiation

def cont ext
st andar d- cont ext

Function
Starts the KnowledgeWorks programming environment.
start-kw e

Starts the KnowledgeWorks programming environment from
the initial prompt when the KnowledgeWorks image is
started. If the LispWorks IDE is already running, st art - kw
adds the KnowledgeWorks menu so that the podium
becomes the KnowledgeWorks Podium.

(start-kw)

Backward Chaining Goal

test lisp-form
lisp-form A single lisp form.

Succeeds if and only if the lisp-form returns a non-ni | value.
Any currently bound variables may be used in the lisp form.
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Examples (test (> ?c 10))
(test (not (and (eq ?a ?b) (nmember ?b ?c))))

undefcontext Macro
Summary Removes a named context and its rules.
Signature undef cont ext context-name & est ignore
Arguments context-name A symbol which names a context.
ignore Ignored arguments.

Description Removes the context named context-name and all the rules in
it.

The ignore arguments are provided so that "un™ may be
prepended to a context definition in an editor buffer and
evaluated to remove the context.

Examples (undef cont ext ny-context)
See also def cont ext
undefrule Macro
Summary Removes a rule.
Signature undefrul e rule-name &rest ignore
Arguments rule-name A symbol which names a rule.
ignore Ignored arguments.

Description Removes the rule named rule-name and any unfired instantia-
tions of that rule.
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The ignore arguments are provided so that "un" may be
prepended to a rule definition in an editor buffer and evalu-
ated to remove the rule.

Examples (undefrul e my-rul el)
See also defrul e
with-rule-actions Macro
Summary Allows rule syntax to be embedded in Lisp code.
Signature wi t h-rul e-acti ons bound-variables &ody body => successp
Arguments bound-variables A list of variables (each starting with ?)
body A rule body.
Values successp A boolean.
Description This macro enables rule syntax to be embedded within Lisp.

The body is executed just as if it were the right hand side of a
forward or backward chaining rule. All variables in the body
(each starting with ?) are taken to be unbound unless found
in the list bound-variables, in which case its value is taken from
the Lisp variable of the same name. It is similar to the func-
tion any but can be compiled for efficiency.

The value successp ist if the body succeeds (that is, all clauses
are successfully executed) or ni | if any of the clauses fail.

Any subgoals that match the object base will only find objects
from the current inferencing state.

127



7 Reference Guide

Example (defun my-fn (?x)
"prints all the lists which append to give ?x and
then returns N L"
(Wi th-rul e-actions (?x)
(append ?a ?b ?x)
((format t "~%S and ~S append to give ~S"
?a ?b ?x))

(fail)))

See also any
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Appendix A

Common Prolog

A.1 Introduction

A.1.1 Overview

Common Prolog is a logic programming system within Common Lisp. It con-
forms closely to Edinburgh Prolog and at the same time integrates well with
Lisp. The basic syntax of Common Prolog is Lisp-like, but an Edinburgh
syntax translator is included that provides the ability to use pre-existing code.
The implementation of Common Prolog was motivated by the desire to use
the logic programming paradigm without having to give up the advantages of
a Lisp development environment. Common Prolog is tightly integrated with
Lisp and can be easily used in a mixed fashion with Lisp definitions even
within the same source file. Common Prolog predicates are compiled into Lisp
functions which may then be compiled by a standard Lisp compiler. Substan-
tial effort has gone into providing a powerful debugging environment for
Common Prolog, so that it can be used when building serious applications.
The implementation of Common Prolog is based loosely on the Warren
Abstract Machine (WAM) modified to take advantage of a Lisp environment’s
built in support for control flow and memory allocation. (For more details of
the WAM, see An Abstract Prolog Instruction Set, by David H D Warren, Techni-
cal Note 309, SRI International, October 1983.)
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A.1.1.1 Starting Common Prolog
Common Prolog may be loaded into an image with the function call:
(require "prol og")

This will load the Common Prolog system. If Common Prolog will be used
extensively, it may be worthwhile to save an image with it pre-loaded. Alter-
natively, you may simply insert the call above into your LispWorks initializa-
tion file (usually . I i spworks).

For information about saving an image and the LispWorks initialization file,
see the LispWorks Release Notes and Installation Guide.

Note: If you load KnowledgeWorks, then Common Prolog is loaded as part of
this.

A.2 Syntax

Common Prolog uses a Lisp-like syntax in which variables are prefixed with
“?” and normal Lisp prefix notation is used. Goals are represented as either
lists or simple vectorse.g. (reverse (1 2 3) ?x) or #(nenber ?x (1 2 3)).
A symbol beginning with ? may be escaped by prefixing another 2.i.e. ?f oo is
the variable named f oo; ??f oo is the symbol ?f oo.

The definition of append/3 from Prolog:

append([], X X).
append([U X, Y, [UZ]) :-
append(X, Y, 2)

translates to:

(defrel append

((append () ?x ?x))
((append (?u . ?x) ?y (?u . ?z))
(append ?x ?y ?z)))

Unlike many Lisp-based logic systems, Common Prolog uses simple vectors
to represent Prolog structured terms. Thus, f unct or, arg, and =. . all behave in
a standard fashion:



(arg 2 (foo 3 4) (3 4))

(arg 2 #(foo 3 4) 4)

(functor (foo 3 4) \. 2)
(functor #(foo 3 4) foo 2)
(=.. #(foo 3 4) (foo 3 4))
(=.. (foo 3 4) (\. foo (3 4)))

A.3 Defining Relations

The normal method of defining relations in Common Prolog is to use the
def r el macro:

(defrel <relation name>
[ (decl are decl aration*)]
<clausel>

<clauseN>)
where each <clause> is of the form:

( <clause head>
<subgoall>

<subgoalN>)

and declarations may include: (nmode ar g- node*) and any of the normal Lisp
optimization declarations. Mode declarations determine how much clause
indexing will be done on the predicate and can also streamline generated code
for a predicate that will only be used in certain ways. A mode declaration con-
sists of the word “MODE” followed by a mode spec for each argument posi-
tion of the predicate. The possible argument mode specs are:

? Generate completely general code for this arg and don’t
index on it.

Y Generate completely general code and index.

+ Generate code assuming this argument will be bound

on entry and index.
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- Generate code assuming this argument will be
unbound on entry and don’t index.

The default mode specs are ?* for the first argument and ? for all the rest.

A.4 Using The Logic Interpreter

The Common Prolog system comes with a built-in r ead- query- pri nt loop
similar to a Prolog interpreter loop. To run it, make sure the common-prolog
package is accessible and type: (r gp) . You will be presented with the prompt:
==>. At this point you may type in goal expressions, for example:

| ==> (append ?x ?y (1 2))
I

| X
| ?2Y

NI L
(12

Now Common Prolog is waiting for you to indicate whether or not you wish
more solutions. If you press Ret ur n, you will get the message Ok and return to
the top level:

[?X = NIL

| 7Y = (1 2)<RETURN>
I

| OK.

I
|::>
A.4.1 Multiple Solutions

If you hit ; (semicolon) following the retrieval of a solution, the system will
attempt to resatisfy your goal:



[?X = NIL
|?2Y = (1 2)
I

| ?X = (1)
| ?Y = (2);
I

|?2X = (1 2)
|?2Y = NIL;
I

| NO.

I

I

When no more solutions remain, NO. is displayed and you are back at the top
level.

A.4.2 Multiple Goals
To request the solution of multiple goals, use: (and <goall> ... <goalN>)
For example:

| ==> (and (nenber ?x (2 3)) (append (?x) (foo) ?y))

2
(2 FOO

< X
I

R

I
I
I
I
I
I
| =-=>

A.4.3 Definitions

It is possible to type logic definitions directly into the interpreter. The result-
ing Lisp code will be compiled in memory and you may use the definition
immediately, for example.:
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==> (defrel color
((color red))
((col or blue))
((col or green)))

<... various conpilation nessages ...>

ES

==> (col or ?x)

A.4.4 Exiting the Interpreter
The Common Prolog interpreter may be exited by typing:

| ==> (halt)

A.5 Accessing Lisp From Common Prolog

It is apparent from the Common Prolog syntax that the first element of any
valid goal expression must be a symbol. Common Prolog takes advantage of
this fact and gives a special interpretation to a goal with a list in the first posi-
tion. A listin the car of a goal is treated as a Lisp expression with normal Lisp
evaluation rules. Any logic variables in the expression are instantiated with
their values. (They must be bound). The rest of the goal expression should be a
list of expressions to be unified with the values returned by the Lisp evalua-
tion. Any extra values returned are ignored, and any extra expressions in the
tail of a goal are unified with new unbound variables.

A.5.1 Examples

=> ((print "foo"))

=> (and (= ?x 3) ((* ?x ?x) ?y))
; Note that "?y" is unified with 9



w

| 2X
| 2Y
I

|==> ((* 3 3) 10)

| NO.
I
| ==> ((floor 3 4) ?2x ?y)
I
| 2X
| 2Y

0
3

| ==> ((floor 3 4) ?x)
I

[?X =0

I

| ==> ((* 3 4) ?x ?y)

I

| ?X = 12

| ?Y = 20
; note that system generated variables | ook |ike:
; ?<integer>
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=> ((typep 3 'integer) ?x)
PX=T

==> ((typep 3 "integer) t)

<
m

S.

==> (and ((floor 5 3) ?x) ((floor 4 3) ?x))

)
X

==> ((cons 3 4) (?x . ?y))

3
4

==> (and (= ?op *) ((list ?op 3 4) ?y) (call (?y ?2)))

20P = *

?Y = (* 3 4)
?Z = 12

==> (and (defrel fact
((fact 0 1))
((fact ?x ?y)
((- ?x 1) 2w
(fact ?w ?z)
((* ?z ?2x) ?y)))

| =
I
I
I
I
I
I
I
I
I
| 7
I
I
I
| ?
| ?
I
I
I
I
| 7
I
I
I
I
I
I
I
I
| (fact 10 ?result))
I

| 2X = 20
|2Y = 21
|7Wz'u
|72z = ?3

|7RESULT = 3628800

A.6 Calling Prolog From Lisp

There are several entry points provided for calling Prolog from Lisp. The main
interface function is called | ogi ¢ and has numerous options. The basic form
is:
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(1 ogi c <goal>
:return-type <return-type>
call <all-type>
: bag- exp <bag-exp>)

The keyword arguments are interpreted as follows:
:return-type describes what to do with a solution when one is found. Possi-
ble values of : ret ur n-t ype are:

- di spl ay Display variable bindings and prompt user (the option
used by the read- query- pri nt loop).

Sfill Instantiate the goal expression and return it.
' bag Instantiate <bag-exp> and return it.
calist Return an alist of variables and bindings.

The defaultis:fill.

:al | tells what to do with multiple solutions. Possible values of : al | are:

ni | Return the first solution.
:val ues Return multiple solutions as multiple values.
tlist Return a list of the solutions.

: bag- exp is an expression that should be instantiated with the bindings from a
solution. This is only meaningful if : ret urn-t ype is : bag.

A.6.1 Examples

(logic '(color ?x) :return-type :display)
writes:

?X = RED<wait for input>

(logic '"(color ?x) :return-type :fill)

returns:
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(COLOR RED)
N

(logic "(color ?x) :return-type :alist)

returns:

((?X . RED))

T

(logic "(color ?x) :all :list)
returns:

((COLOR RED) (COLOR BLUE) (COLOR GREEN))
T

(logic "(color ?x)
:return-type : bag
:bag-exp '(?x is a color)
call :val ues)
returns:

(RED I'S A COLOR)
(BLUE I'S A COLOR)
(GREEN | S A COLOR)

A.6.2 Interface Functions

Three simple interface functions call | ogi c. They are ANY, FI NDALL, and FI ND-

ALLSET. Each takes two arguments: a result expression to instantiate and a goal
expression. ANY returns the first solution found. FI NDALL returns all solutions.
FI NDALLSET returns all solutions deleting duplicates.

A.6.2.1 Examples
Assuming the definitions for f act and col or from the previous examples.
| (any '(?x is the factorial of 5) '(fact 5 ?x))

returns:
I

| (120 I'S THE FACTORI AL OF 5)
I
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| (findall '"(?x is a color) '(color ?x))

returns:

I
| ((RED IS A COLOR) (BLUE IS A COLOR)
(GREEN IS A COLOR))

I
| (findall "?y '"(or (=?y 5) (=7?y 5)))

returns:

I
| (5 5)

I
| (findallset "?y "(or (= ?y 5) (=1?y 5)))

returns:

I
| (5)

FI NDALL and FI NDALLSET will hang if a goal expression generates an infinite
solution set.

More powerful all solution predicates (BAGOF and SETOF) are available from
within Common Prolog.

A different interface is available for predicates which will be called often from
Lisp. The macro def | ogf un may be used to generate normal Lisp functions
that run with precompiled goals.

A.6.2.2 Example

(defl ogfun break-up (y) (append ?a ?b y) (?a ?b))
then:

(break-up ' (foo bar baz))
returns:

(NI'L (FOO BAR BAZ))
T

(break-up '(foo bar baz) :all :values)
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returns:

(NIL (FOO BAR BAZ))
((FOO (BAR BAZ))
((FOO BAR) (BAZ))
((FOO BAR BAZ) NIL)
(b

reak-up '(foo bar baz) :all :list)
returns:

((NI'L (FOO BAR BAZ))
((FOO) (BAR BAZ))
((FOO BAR) (BAZ))
((FOO BAR BAZ) NiL))
T

A final interface mechanism iswi t h- prol og. wit h-prol og allows one to
embed prolog into an arbitrary lisp function. Lisp variables are referenced in
Prolog using “?. <name>".

A.6.2.3 Example

(defun palindromep (x)
(wi th-prol og
(append ?a (?b . ?c) ?.x) ; note "?.x" reference
(or (reverse ?a ?c)
(reverse ?a (?b . ?¢)))))

(palindromep '(yes no naybe))
returns:

NI L

(palindromep ' (yes no naybe no yes))
returns:

T

The body of awi t h- prol og returnst if it succeeds and a non-local exit is not
executed. It returns nil on failure.



A.7 Debugging

Common Prolog provides a standard 4-port debugging model (cal | exi t
redo fail ). Tracing, Spy Points, Leashing, and interactive debugging will each
be discussed separately.

A.7.1 Tracing

Exhaustive tracing is available with Common Prolog through the use of:
(trace). After executing (trace), all goals will be displayed until control is
returned to the top level loop, nodebug is executed or not r ace is executed.

A.7.2 Spy Points

Spy points are the most important debugging facility in Common Prolog.
They are used in the same way t r ace is used in Lisp. After executing ( spy

f 00), all events associated with satisfying f oo goals will be traced and the user
will enter a debugging command loop at every port (see Interactive Debug-
ging below). A user can also specify (spy (foo 3)), (spy (foo bar)), or
(spy ((foo 3) bar)) to place spy points on f oo goals with arity 3, on all
predicates for f oo and bar, or on f oo with arity 3 and all predicates for bar
respectively. Spy points are turned off with (nospy <spypoints>). If no spy
points are mentioned, nospy will turn off all spy points.

A.7.3 Leashing

Leashing allows the user to control execution while tracing for goals that are
not spied. Spied goals cause execution to enter a debugging command loop
whenever they are reached. Leashing provides the same functionality for
unspied goals. A user may choose to enter a debugging command loop at any
subset of ports by using (1 eash <events>) where events may be: call, redo, exit,
fail. Leashing may be turned off using (unl eash).

A.7.4 Interactive Debugging

When Common Prolog execution enters a debugging command loop, the user
has many options, which may be listed with 2, for example:
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| ==> (spy nenber)
((MEMBER 2))

YES.

oK.

==> (menber 3 ?x)

[1] CALL: (MEMBER 3 ?0)? ? <- user types ?

(c)reep - turn on exhaustive tracing
(s)kip - skip until another port is
reached for this goa
(1)eap - turn off tracing until a spy
point or this goal is reached
(b)reak - enter a recursive
read/ query/print |oop
(d)isplay - display a listing for the
current goa
(quit - quit to top |evel
(r)etry - try to satisfy this goal again
(f)ail - cause the current goal to fai
(a) bort - exit Common Prol og
? - display this infornation
?

Inalittle nore detai

creep - causes exhaustive tracing of the
next goa
skip - ignores spy points and executes

wi t hout di spl ayi ng anyt hi ng unti
this goal is reached again
either at an exit, fail,

or redo port

| eap - turns off exhaustive tracing until
a spy point or this goal is
reached

br eak - enters a recursive interpreter |oop

so that the user nay query

val ues, redefine a predicate, etc
di splay - uses "listing" to display the

listing of the current goal

quit - returns to the top level interpreter
| oop
retry - causes execution to return to the



call port of this goal as if
this goal had just been reached for
the first time

fail - causes execution to junp to the fai
port of this goa
abort - conpletely exit Common Prol og

Continuing the example:

| d <- user selects display

I

| Conpi | ed procedure:

I

| (DEFREL MEMBER

|  ((MEMBER ?X (?X . ?)))

|  ((MEMBER ?X (? . ?Y)) (MEMBER ?X ?Y))) ? ¢
| ...user selects creep

[[1] EXIT: (MEMBER 3 (3 . 20))? r

| ...user selects retry

I[l] CALL: (MEMBER 3 ?0)? f <-user selects fail
I[l] FAIL: (MEMBER 3 ?0)? r <- one nore tine
I[l] CALL: (MEMBER 3 ?0)? s <- skip

I
[[1] EXIT: (MEMBER 3 (3 . 20))? | <- leap

| ?X = (3 . ?0); <- nore solutions
I
|[1] REDO (MEMBER 3 (3 . ?0))? c <- creep

I
|[2] CALL: (MEMBER 3 ?0)? b <- break

==> (nospy)

| NIL <- current spylist
| YES.

| OK.

| ==> (halt) <- return to original execution
|? 1 < leap

I
| ?X = (?0 3 . ?1)<cr>
I

| OK.
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Another example:

| ==> (defrel reverse

I ((reverse () ()))

| ((reverse (?x . ?y) ?z)
| (reverse ?y ?w

| (append ?w (?x) ?z)))
| <noi se. . >

I

| 2X = 20
|?2Y = 71
| 22 = 72
| ?W= 23
I

| OK.

==> (defrel append
((append () ?x ?x))

(append ?x ?y ?z)))
<noi se. . >

I
I
| ((append (?u . ?x) ?y (?u .
I
I

| 2X = 20
|?2U = 71
| ?2Y = 72
| 2Z = 73
I

| OK.

| ==> (unl eash)
I

| YES.

| K.

I

| ==> (trace)

I
| YES.
| OK.

?z))



| ==> (reverse (1 2 3) ?x)

—_—

CALL: (REVERSE (1 2 3) 20)
CALL: (REVERSE (2 3) ?20)
CALL: (REVERSE (3) ?0)

CALL: (REVERSE NIL ?0)

EXIT: (REVERSE NIL NI L)
CALL: (APPEND NIL (3) 20)
EXIT: (APPEND NIL (3) (3))
EXIT: (REVERSE (3) (3))
CALL: (APPEND (3) (2) 20)
CALL: (APPEND NIL (2) 20)
EXIT: (APPEND NIL (2) (2))
EXIT: (APPEND (3) (2) (3 2))
EXIT: (REVERSE (2 3) (3 2))
CALL: (APPEND (3 2) (1) ?0)
CALL: (APPEND (2) (1) 20)
10] CALL: (APPEND NIL (1) ?20)
10] EXIT: (APPEND NIL (1) (1))
9] EXIT: (APPEND (2) (1) (2 1))
8] EXIT: (APPEND (3 2) (1) (3 2 1))
1] EXIT: (REVERSE (1 2 3) (3 2 1))
X = (3 2 1);

—

—_

S e e R B e W e e e e B e W e e e B e B B e R

[1] REDO (REVERSE (1 2 3) (3 2 1))
[8] REDO (APPEND (3 2) (1) (3 2 1))
[9] REDO (APPEND (2) (1) (2 1))
[10] REDO. (APPEND NIL (1) (1))
[10] FAIL: (APPEND NIL (1) 20)
[9] FAIL: (APPEND (2) (1) 20)
[8] FAIL: (APPEND (3 2) (1) ?0)
[2] REDO (REVERSE (2 3) (3 2))
[6] REDO. (APPEND (3) (2) (3 2))
[7] REDO. (APPEND NIL (2) (2))
[7] FAIL: (APPEND NIL (2) 20)
[6] FAIL: (APPEND (3) (2) 20)
[3] REDO (REVERSE (3) (3))

[5] REDO. (APPEND NIL (3) (3))
[5] FAIL: (APPEND NIL (3) 20)
[4] REDO (REVERSE NIL NIL)

[4] FAIL: (REVERSE NIL ?0)

[3] FAIL: (REVERSE (3) ?0)

[2] FAIL: (REVERSE (2 3) ?0)

[1] FAIL: (REVERSE (1 2 3) 20)
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A.8 Common Prolog Macros
Macros may be defined within the logic system using the form:
(defrel macro <name> <arg-list> <body>)

which is effectively the same as a Common Lisp def macr o. Logic macros are
expanded before variable translation so that logic variables may be treated as
atoms. def r el macr o forms must have a fixed number of arguments. This
allows different predicates with the same name but different aritys to be
defined. If you want to define a special form with an arbitrary number of
arguments, use defrel - speci al - f or m nacr o.

A.8.1 Example

(defrel macro append3 (x y z w)
(let ((iv (make-internal-var)))
‘(and (append ,x ,y ,iv)

(append ,iv ,z ,w))))

==> (append3 (1) (2) (3) ?y)
2Y = (1 2 3)

A.9 Defining Definite Clause Grammars

The def granmmar macro can be used to define a definite clause grammar
(DCG), which is a relation that determines whether the start of a list of tokens
(a sentence) matches a particular grammar. The remaining tokens in the list
become the sentence tail.

The relation has the form

(<grammar name> <sentence> <sentence tail> <extra argunent >*)
where the <extra ar gunent > items are terms defined below.
The syntax of the defgrammar macro is

(def grammar <granmar nanme>
<rul e>*)

<rule> ::= (<l hs> <rhs>*)



<l hs> ::= <grammar name>
| (<granmar name> <ternp*)

<r hs> = <atonp

| <var>

| (<other granmar name> <ternp*)

| <lisp clause>

| (call <termp)

| (cut)
<lisp clause> ::= (<non-atonmic lisp forms <ternp*)
<non-atomc lisp fornk ::= (<lisp function name> <lisp arg>*)

<granmmar nane> is the same symbol as the one naming the defgrammar
<ot her grammar name> is a symbol naming another defgrammar

<at on is an atom, which forms the words of the sentence to be matched
<var > is a variable reference

<t er mp is any Common Prolog logic expression, including a variable

<lisp function name> is asymbol naming a Lisp function

<l isp arg>isany Lisp form, which is evaluated and passed to the function

Within the <I hs>, extra arguments can be added by specifying <t er n»s. Every
<r ul e> must specify the same <gr ammar name> as the def gr ammar form and

have the same number of extra arguments.
The meaning of the various <r hs> items is as follows:
= <at onr matches that atom in the sentence
= <var > is unified with the next item in the sentence

e (<other grammar nane> <termp*) calls the grammar relation

<ot her grammar name> on the rest of the sentence. The optional <t er n»

arguments are passed to the relation as its extra arguments.

e <lisp clause>evaluates the <non-atomic lisp forme asa Lisp form

and unifies the values that it returns with the <t er mes that follow it.
e (call <ternp) calls <t er > as a normal Prolog relation.

= (cut) calls the normal Prolog cut relation.
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A.9.1 Examples

Here are some examples of using def gr ammar.

A.9.1.1 Example 1: A simple definition.

This example shows the Common Prolog translation of the grammar shown at
the top of ht t p: // www. col i . uni - saar | and. de/ ~kri s/ | ear n- pr ol og-
now ht m / node59. ht m

(def granmar gram det
(gramdet the)
(gramdet a))

(def granmar gramn
(gram n wonan)
(gramn man))

(def granmar gramv
(gramv shoots))

(def granmar gram np
(gramnp (gramdet) (gramn)))

(def granmar gramvp
(gramvp (gramv) (gramnp))
(gramvp (gramv)))

(def granmar grams
(grams (gramnp) (gramvp)))

Note the use of symbols for terminals and lists for non-terminals. They all use
the first form of the <l hs> and have no extra terms on the <r hs>, so all of the
relations are binary.

The following will both succeed and bind ?x to the list (f oo bar):

(clog:any '?x '(grams (a wonan shoots foo bar) ?x))
(clog:any '?x '(grams (a wonan shoots the man foo bar) ?x))



A.9.1.2 Example 2: Using extra arguments.

(def grammar one- of
((one-of ?word) ?word))

(def granmar t wo- of
((two-of ?word) (one-of ?word) (one-of ?word)))

Each of these defines a 3-ary relation, whose extra argument is the word to
match. When the relations are called, the word will typically be bound to a
symbol from the sentence to match.

The following will succeed and bind ?x to the list (f oo bar):
(clog:any '?x '(two-of (start start foo bar) ?x start))

The following will both fail because the sentences do not begin with two
start symbols:

(clog:any '?x '(two-of (not-start start foo bar) ?x start))
(clog:any '?x '(two-of (start not-start foo bar) ?x start))

A.10 Edinburgh Syntax

Common Prolog provides a translator from Edinburgh syntax to allow users
to port pre-existing code.

The consul t predicate operates only on . pl files:
e consul t (' xxx. pl') means consult file xxx. pl .
e consul t (' xxx'). means find a file named xxx. pl| and consult it.

Thereconsul t predicate can operate on a Lisp source file, since
conpi | e_and_reconsul t (' xxx. pl ') produces a Lisp binary file xxx. ?f asl
That is, reconsul t will load fasl and lisp files as well as . pl files:

e reconsul t (' xxx. pl ') means reconsult file xxx. pl .

= reconsul t (' xxx') means look for a file named xxx. ?f asl and load it,
or if none found, look for xxx. pl and reconsult it, or if none found look
for xxx. I'i sp and load it, or load xxx.

Loading a compiled file is equivalent to r econsul t .

conpi | e_and_r econsul t compiles a file and reconsults the result.
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Edinburgh syntax may also be used to interact with Common Prolog through
the use of a different read-query-print loop. To use Edinburgh syntax, use
(erqgp) instead of (rqgp) to start your command loop.

A.11 Graphic Development Environment

Common Prolog includes a graphic environment for users with bitmap dis-
plays. The environment consists of a specialized listener and graphic debug-
ging tools. With the debugging tools it is possible to step through a program at
the source level and control the 4-port debugger using the mouse. Call trees
for predicates may also be displayed and manipulated.

The specialized listener provides mouse control over:
= File editing, compiling, consulting and reconsulting
< Debugging control flow (creep, leap, skip, etc.)
= Leashing of debugging ports
= The addition and deletion of spy points.

The Logic Listener interaction is similar to a normal Lisp Listener and will
accept normal Lisp expressions except that:

1. Any expression that can be interpreted as Common Prolog will be han-
dled by the Logic subsystem.

2. Ifaline consisting of just *?- is entered, the Logic Listener will go into an
Edinburgh (ergp) loop.



A.12 Built-in Predicates

[== (?x ?y)

(?x ?y)
(?x ?y)

== (?X ?Y)

@ (?x ?y)

@< (?x ?y)

@ (7x ?y

@= (?x ?y)

append (?x ?y ?z)

arg (+index +term ?val ue)

asserta (+exp)

assertz (+exp)

atom c (?x)

bagof (?exp
(+goal
?bag)

call (+exp)

clause (+head ?tail)

debug ()

+ex-vars)

debuggi ng ()
def detrel

(+name &rest +cl auses)
def gramar

(+nane &rest +rul es)
defrel

(+name &rest +cl auses)
defrel macro

(+name +args &rest
+body)

same as Prolog \ ==
standard Prolog
standard Prolog
standard Prolog

same as Prolog except all variables
sort as identical

ditto

ditto

ditto

standard Prolog

standard Prolog

standard Prolog

standard Prolog

standard Prolog

standard Prolog (unusual syntax)*

standard Prolog
standard Prolog

cause debugging information to be
saved for each call whether it is
spied or not

display a list of all spied goals
define a relation and declare it to be

deterministic
define a grammar rule

define a relation

define a logic macro

151



152

defrel - speci al -f orm macr o like defrelmacro but can have

(+name +args &rest
+body)

determ ni stic (+nane)
erase (+ref)

fail ()
findal |
(?exp +goal <?result)

findall set
(?exp +goal <?result)

functor
(?term ?functor ?arity)

halt ()

i nteger (?x)

is (?result +exp)
keysort (+in ?out)

| eash (+event-spec)

listing

(+nane &opti onal
+arity)
menber (?x ?y)
nodebug ()

nonvar (?x)
nospy (+args)

not (+x)

&rest in +ar gs. Use of this form
will shadow all predicates named
+name regardless of arity.

declare the relation called ?nane to
be deterministic

delete the predicate with database
reference ?ref from the database
standard Prolog

generate all solutions to ?goal and
instantiate ?exp with the values.
Return a listin ?resul t.

same as findall/3 but removes dupli-
cates

standard Prolog

exit Common Prolog

standard Prolog

standard Prolog

standard Prolog except uses alist
style cons pairs

cause the interpreter to pause and
ask for input when one of the
leashed events is traced. An event-
spec is one of: (cal | exit redo fail),
or a list of ports.

display a listing of the named predi-
cate or listings for each arity if no
arity is specified

standard Prolog

leave debug mode (cease saving
debug info for non-spied goals)
standard Prolog

remove +ar gs from the list of spied
goals. +args may be a predicate
name or a list of predicate names.
Unspy all goals if +ar gs is nil
standard Prolog



notrace ()

once (+exp)

out put -defrel s
(+name ?defrels)

read-term (?term
recorda (+exp ?val ?ref)

recorded (+term ?val
?ref)

recordz (+exp ?val ?ref)

repeat ()

retract (+cl ause)

setof (?exp
(+goal
?bag)

sort (+in ?out)

spy (+args)

+ex-vars)

trace ()

transl ate-vars
(?intern ?extern)

turn off exhaustive tracing for
debugged goals

satisfy +exp as a goal once, then
fail on retrying even if +exp has
more solutions: this can be used to
make a call deterministic so that the
compiler can perform last call optimi-
zation

return a list of def r el expressions
derived from the dynamic clauses
associated with ?nane

read in a term

standard Prolog

standard Prolog

standard Prolog
standard Prolog
standard Prolog
standard Prolog (unusual syntax)*

standard Prolog

spy +args. +args may be a pred-
icate name or a list of predicate
names. If arity is not mentioned for a
predicate name, predicates of all
aritys with that name are spied.

turn on tracing for debugged goals,
also turn on debugging for the next
top level goal

translate back and forth between
internal and external variable repre-
sentations. Can be used to pretty up
the writing of terms containing vari-
ables
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true () standard Prolog

unl eash (+event-spec) Undo leashing for +event - spec.
+event-spec may be a port or a list
of ports. If +event - spec is nil, all
ports are unleashed.

var (?x) standard Prolog
* set of and bagof in standard Prolog use a special syntax for existentially
guantified variables, for example:
?- setof (X, Yrfoo(X YY), 2).
In Common Prolog, this would look like:
==> (setof ?x ((foo ?x ?y) ?y) ?z)

So, a goal with no existentially quantified variables is nested in an extra set of
parentheses:

==> (bagof ?x ((bar ?x)) ?z)

A.13 Adding Built-in Predicates

Common Prolog provides several special forms for adding new predicates
written in Lisp. Each one is described below, with an example.

A.13.1 The defdetpred form
The syntax of this form is
(def det pred <name> <num args> <body>)

which defines a simple predicate that just runs lisp code and doesn’t have to
unify any variables. Arguments are referenced with:

(speci al -arg <argnum>). The body succeeds by default, but if a failure case
arises, use: (detpred-fail <name> <num args>) .

For example



(defdetpred mnmy-integer 1
(unless (integerp (special-arg 0))
(detpred-fail ny-integer 1)))

A.13.2 The defdetunipred form
The syntax of this form is

(def det uni pred <name> <num args> <unifierl unifier2>
<aux-vars> <body>)

def det uni pr ed is used when the defined predicate needs to unify values with
arguments (or unify in general). The body is executed and, if successful, (that
is, det pred-f ai | has not been called) unification is performed on the two uni-
fiers. (If more than two items need to be unified, cons up lists of items to

unify).

For example

(defdetuni pred my-arg 3 (tenpl temp2)
(tenpl tenmp2 index term val ue)
(setf index (special-arg 0)
term (special-arg 1)
val ue (special-arg 2))
(unl ess (and (numberp index)
(pl usp index)
(or (and (termp term
(< index (length term))
(and (consp term
(< index 3))))
(detpred-fail ny-arg 3))
(if (consp tern
(setf templ (if (= index 1)
(car term
(cdr term))
(setf templ (termref termindex)))
(setf tenp2 val ue))

A.14 Edinburgh Compatibility Predicates

The following predicates all have their standard Edinburgh definitions:
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current-op
di spl ay
get
getO

is

name

nl

put

see
seei ng
seen
ski p
tell
telling
told
ttynl
ttyput
wite
witeq
lis]
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Appendix B

Examples

B.1 The Tutorial

The code for the tutorial (Chapter 2, “Tutorial) is reproduced for easy refer-
ence.

; -*-mode : lisp ; package : kw user -*-

(i n-package kw- user)

(def -kb-cl ass node ()

((animal :initformnil :accessor node-ani nal
cinitarg :animal)
(question :initformnil :accessor node-question
rinitarg :question)
(yes-node :initformnil :accessor node-yes-node
rinitarg :yes-node)
(no-node :initformnil :accessor node-no-node

cinitarg :no-node)))

(def -kb-class root ()
((node :initformnil :accessor root-node
sinitarg :node)))

(def -kb-struct current-node node)
(def -kb-struct gane-over node ani nal answer)

D1 e FORWARD CHAI NI NG RULES - ------==----
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;;, if there is no question we are about to ask then
77, ask the question which is the root question of the
7, question tree

(defrule play :forward
(root ?r node ?node)
(not (current-node ? node ?))
-->
((tk:send-a- nessage
(format nil " AN MAL GUESSI NG GAME - ~
think of an animal to continue")))
(assert (current-node ? node ?node)))
;;; ask a yes/no question - these are non-|leaf questions

(defrul e y-n-question :forward

(current-node ?current node ?node)

(node ?node animal nil question ?q yes-node ?y-n
no- node ?n-n)

-->

((tk:confirmyes-or-no ?q) ?answer)

(erase ?current)

((find-new node ?answer ?y-n ?n-n) ?newcurrent)

(assert (current-node ? node ?newcurrent)))

(defun find-new node (answer yes-node no-node)
(i f answer yes-node no-node))

77, ask an animal question - these a |eaf questions

(defrul e ani mal - question :forward

(current-node ?current node ?node)

(node ?node ani mal ?ani mal question nil)

-->

((tk:confirmyes-or-no
(format nil "Is it a ~a?" ?animal)) ?answer)

(erase ?current)

(assert (ganme-over ? node ?node ani mal ?ani ma
answer ?answer)))

;;; add new nodes to the tree for the new ani mal and
;;; the question that distinguishes it
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(defrul e new question :forward

tpriority 20
(gane-over ? node ?node ani mal ?ani mal answer nil)
-

(fetch-new ani mal ?new ani mal )
((tk: popup-pronpt-for-string
(format nil "Tell ne a question for which the ~

answer is yes for a ~a and no for a ~a"
?new ani mal ?ani mal )) ?questi on)

(assert (node ?yes-node question ni
ani mal ?new ani mal ))

(assert (node ?no-node question nil aninmal ?aninal))

(assert (node ?node animal nil yes-node ?yes-node
no- node ?no-node question ?question)))

;,, game is over

(defrul e gane-finished :forward
tpriority 15
(game-over ?g)
-->
(erase ?9)
i (test (not (tk:confirmyes-or-no "Play again?")))
(return))

N BACKWARD CHAI NI NG -------=-=-=-------
;;, pronpt user for new aninal

(defrul e fetch-new ani mal :backward
((fetch-new ani mal ?new ani mal )
<- -
; (repeat)
((string-upcase
(tk: popup-pronpt-for-string
"What was your ani mal ?"))
?new ani mal )
(not (= ?newanimal "N L"))
; check if abort was pressed
(or
(doesnt - exi st-al ready ?new ani rmal)
(and ((tk:send-a-nessage "Animal exists already"))

(fail)))))

77, check if a node already refers to this animal
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(defrul e doesnt -exist-already :backward
((doesnt - exi st-al ready ?ani nmal)
<- -
(node ? animal ?aninmal)
(cut)
(fail))
((doesnt - exi st-al ready ?ani nmal)

<--))
--------------- SAVI NG THE ANI MAL BASE - -----------

;7 wites out code which when | oaded reconstructs the
7, tree of questions

(defun save-animals (fil enane)
(let* ((start-node (any ‘?node ‘(root ? node ?node)))
(code ‘ (make-instance ‘root
:node , (node-code start-node)))
(*print-pretty* t))
(wi th-open-file
(stream filenane :direction :output
tif-exists :supersede)
(wite ' (in-package kw user) :stream stream
(write-char #\ New ine stream
(wite code :stream stream)

nily)

(defun node-code (node)
(when node
‘ (make-i nstance ‘ node
:question , (node-question node)
:ani mal ‘, (node-ani mal node)
:yes-node , (node-code (node-yes-node node))
: no- node , (node-code (node-no-node node)))))

B.2 Explanation Facility

Below is the complete code implementing the simple explanation facility of
Chapter 6, “A Simple Explanation Facility”. The implementation principle is
exactly as described.

Taa T A SI MPLE EXPLANATION FACILITY ---------

(i n-package kw- user)
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; connects rule to explanation definitions
(defvar *expl anation-tabl e*
(make-hash-table :test # eq))

; explanation generated at runtime
(defvar *explanation* nil)

;55 the next four definitions make up the defexplain
;;: macro for each of the why, what and because

77, definitions we create a function which we can cal
;7. at runtinme on the bindings of the instantiation to
;,, generate the explanation text - this will be

;;, reasonably efficient

(defun is-var (expr)
"is this a variable (i.e. starts with ?)"

(and (symbol p expr)
(eql (char (synbol-nane expr) 0) #7?)))

(defun find-vars (expr)
"returns a list of all the variables in expr”
(if (consp expr)
(append (find-vars (car expr))
(find-vars (cdr expr)))
(if (is-var expr) (list expr) nil)))

(defun nmake-expl ai n-func (expl ain-stuff)
"generates a function to generate explanation text at
runtime"”
(let* ((explain-string (car explain-stuff))
(expl ain-args (cdr explain-stuff))
(vars (renove-duplicates
(find-vars explain-args))))
“#' (I ambda (bi ndi ngs)
(let ,(mapcar
# (1l anbda (v)
“(,v (cdr (assoc ‘,v bindings))))
vars)
(format nil ,explain-string
@xpl ain-args)))))

(def macro defexplain (rul enane & ey why what because)
"puts an entry for the rule in the explanation table"
‘(setf (gethash ‘', rul ename *expl anation-tabl e*)

(list ,(make-explain-func why)
, (make- expl ai n-func what)
, (make- expl ai n-func because))))
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next two definitions generate an expl anation for
;;, each instantiation that fires and stores it away in
;. *explanation*

(defun add-expl anati on (inst)
"generate an explanation for firing this
instantiation"
(let ((explain-info
(gethash (inst-rul enane inst)
*expl anati on-tabl e*)))
(when expl ain-info
(do-the-rest explain-info (inst-bindings inst)))))

(defun do-the-rest (explain-info bindings)

"creates explanation text derived from explain

functions and bindi ngs"

(let ((why-func (first explain-info))
(what - func (second expl ai n-info))
(because-func (third explain-info)))

(push * (,*cycle* ,(inst-rul ename inst)
, (funcal | why-func bindi ngs)
, (funcall what-func bindi ngs)
, (funcal | because-func bi ndi ngs))
*expl anation*)))))

;. nmeta-interpreter for explanation contexts
;;, before firing the rul e generate explanation for
;7. this cycle

(defrul e expl ai n-context : backward

((expl ai n-cont ext)

<- -

(start-cycle)

(instantiation ?inst)
((add- expl anati on ?inst))
(fire-rule ?inst)

(cut)

(expl ai n-context)))

sinple text output of the explanation

(defun explain (&optional cycle)
"print out either the whol e explanation or just for
one cycl e”
(if cycle (explain-cycle (assoc cycle *explanation*))
(dolist (cycle-entry (reverse *expl anation*))
(expl ain-cycle cycle-entry))))
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(defun expl ain-cycle (entry)
"print this explanation entry"
(if entry
(let ((cycle (first entry))
(rul ename (second entry))
(why (third entry))
(what (fourth entry))
(because (fifth entry)))
(format t "~2%a: ~a~%-a~%-a~%a"
cycl e rul enane why what because))
'~2%No expl anation for this cycle")))

(format t '
;7 we could neke a really smart tool here, but to give
;;; the general idea...

(defun expl ai n-an-action ()
(let ((item
(tk:scroll abl e-nmenu
(reverse *expl anati on*)
:title "Which action do you want
expl ai ned?"
:name-function # (lambda (x) (fourth x)))))
(if item(tk:send-a-nessage (fifthitem))))

;;, starting the rule interpreter should clear any old
;7 explanation

(defadvice (infer rest-explanation :before)
(&rest args)
(unless *in-interpreter* (setq *explanation* nil)))

Below are some example rules using the explanation facility. They are taken
from the Monkey and Banana Example distributed with KnowledgeWorks.
The classes used in the example are nonkey, obj ect and goal .

(defrule mb7 :forward
:context mab
(goal ?g status active type hol ds object ?w)
(obj ect ?0l1 kb-nane ?w at ?p on floor)
(monkey ?mat ?p holds nil)
-->
((format t "~%ab ~s" ?w))
(assert (nmonkey ?m hol ds ?w))
(assert (goal ?g status satisfied)))
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(def expl ain b7

:why ("Mnkey is at the ~s which is on the floor" ?w)
:what ("Monkey grabs the ~s" ?w)
:because ("Mnkey needs the ~s sonewhere el se" ?w))

(defrule nmbl2 :forward

:context nmab

:context nmab

(goal ?g status active type wal k-to object ?p)
(rmonkey ?mon floor at ?c holds nil)

(test (not (eq ?c ?p)))

-->

((format t "~%Mlk to ~s" ?p))

(assert (monkey ?mat ?p))

(assert (goal ?g status satisfied)))

(defexplain nbl2

:why ("Monkey is on the floor holding nothing")

swhat ("Monkey wal ks to ~s" ?p)

: because ("Mnkey needs to do sonething with an
object at ~s" ?p))

(defrule nmbl3 :forward

:context mab

(goal ?g status active type wal k-to object ?p)
(rmonkey ?mon floor at ?c holds ?w)

(test (and ?w (not (eq ?c ?p))))

(obj ect ?0l1 kb-nane ?w)

-->

((format t "~%Mlk to ~s" ?p))

(assert (nmonkey ?m at ?p))

(assert (object ?01 at ?p))

(assert (goal ?g status satisfied)))

(defexplain nbl3

:why ("Monkey is on the floor and is holding the ~s"
W)

:what ("Mnkey walks to ~s with the ~s" ?p ?w)

:because ("Mnkey wants the ~s to be at ~s" ?w ?p))

(defrule nmbl4 :forward

:cont ext nmab

(goal ?g status active type on object floor)
(monkey ?m on ?x)

(test (not (eq ?x ‘floor)))

-->

((format t "~%unp onto the floor"))

(assert (rmonkey ?mon floor))

(assert (goal ?g status satisfied)))



(defexplain nmbl4
:why ("Mnkey is on ~s" ?x)
:what ("Monkey junps onto the floor")
: because ("Mnkey needs to go sonmewhere"))

(defrule nmbl7 :forward
:context nmab
(goal ?g status active type on object ?0)
(obj ect ?0l1 kb-nane ?0 at ?p)
(rmonkey ?m at ?p holds nil)
-->
((format t "~% inb onto ~s" ?0))
(assert (monkey ?m on ?0))
(assert (goal ?g status satisfied)))

(defexplain nmbl7
:why ("Mnkey is at the |ocation of the ~s" ?0)
:what ("Mnkey clinbs onto the ~s" ?0)
: because ("Mnkey wants to be on top of the ~s" ?0))

(defrule nbl8 :forward
:cont ext nmab
(goal ?g status active type holds object nil)
(rmonkey ?m hol ds ?x)
(test ?x)
-->
((format t "~%brop ~s" ?X))
(assert (monkey ?mholds nil))
(assert (goal ?g status satisfied)))

(defexplain nbl8
:why ("Mnkey is holding the ~s" ?x)
:what ("Monkey drops the ~s" ?x)
:because ("Mnkey wants to do sonething for which he
can’t hold anything"))

B.3 Uncertain Reasoning Facility

Below is the complete code which implements the uncertain reasoning facility
of Chapter 6, “Reasoning with Certainty Factors”. The implementation is
exactly as described with a few extra considerations to check the rule inter-
preter is running before returning an uncertain value, that the objects have a
certainty-factor slot and so on.

N S| MPLE REASONI NG W TH UNCERTAI NTY FACTORS - ---

(i n-package kw user)
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7, default certainty factor
(defvar *c-factor* 1)

7, inplication strength of a rule
(defvar *inplication-strength* 1)

(defun default-c-factor ()
"if the forward chainer is not running, certainty
factor is just 1"
(if *in-interpreter®*
(* *inplication-strength* *c-factor*)

1)

;7. uncertain objects need a slot to store their
;;, ‘probability’ this slot defaults to the val ue
;;, returned by default-c-factor

(def -kb-cl ass uncertai n- kb-object ()
((c-factor :initform (default-c-factor)
sinitarg :c-factor)))

(defun object-c-factor (obj)
"if an object has no uncertainty slot, return 1 (i.e.
certain)"
(if (slot-exists-p obj ‘c-factor)
(slot-value obj ‘c-factor)

1)

(defun inst-c-factor (inst)
"the certainty factor of an instantiation"
(token-c-factor (inst-token inst)))

(defun token-c-factor (token)
"the certainty factor of an ANDed |ist of objects
(just multiply them"
(reduce ‘* (mapcar ‘object-c-factor token)))

(defun inplication-strength (val)
"for a rule to set the inplication strength"
(setq *inplication-strength* val))

;55 this function increases the certainty of the object
;55 which is the first argument by an anmpbunt dependent
;5: on the conbined certainty of the remmining

5, arguments
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(defun add-evi dence (obj &rest token)

"increnents the certainty of obj based on the
certainty of token"
(let ((c-f (slot-value obj ‘c-factor)))
(setf (slot-value obj ‘c-factor)
(+ c-f
(* (- 1 c-f) *inplication-strength*
(token-c-factor token))))))

;;: this tactic is dynanmic as the certainty factor slot
;7: gets changed by cal ling add-evidence

(deftactic certainty :dynamc (il i2)
"a conflict resolution tactic to prefer nore certain
instantiations"
(> (inst-c-factor il) (inst-c-factor i2)))

;;; Before firing a rule this nmeta-interpreter just

77, sets the value of *c-factor* to the certainty of

;75 the instantiation so that any new uncertain objects
;75 made get this (times *inplication-strength*) as

;55 their certainty. Al so sets *inplication-strength?*
;;; tol as a default in case the rule doesn't set it.

(defrul e uncertain-context :backward
((uncertain-context)
<- -
(start-cycle)
(instantiation ?inst)
((progn (setq *c-factor* (inst-c-factor ?inst))
(setq *inmplication-strength* 1)))
(fire-rule ?inst)
(cut)
(uncertain-context)))

Below are some example rules using this facility for a simple car maintenance
problem.

---------------- SOVE EXAMPLE RULES ---------------
;55 to run: (run-diagnose)

(def -kb-struct start)

(def -kb-cl ass synptom (uncertai n-kb- obj ect)
((type :initarg :type)))

(def-kb-class fault (uncertain-kb-object)
((type :initarg :type)))

(def -kb-cl ass remedy (uncert ai n-kb-object)
((type :initarg :type)))
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this context sets up the initial hypotheses and
gathers evidence this doesn't need the neta
-interpreter as that's only necesssary for
transparent assignnment of certainty factors to new

;;, objects

(def context di agnose :strategy ())

(defrule start-rule :forward
:context di agnose

(start ?s)

-->

(assert (synmptom ? type over-heat c-factor 1))
(assert (synptom ? type power-loss c-factor 1))
(assert (fault ? type lack-of-o0il c-factor 0.5))
(assert (fault ? type | ack-of-water c-factor 0))
(assert (fault ? type battery c-factor 0))
(assert (fault ? type unknown c-factor 0))

(context (cure)))

next context onto agenda

(defrul e diagnosel :forward
:context di agnose
(synptom ?s type over - heat)
(fault ?f type | ack-of-water)

o>

((inmplication-strength 0.9))
((add-evi dence ?f ?s)))

(defrul e diagnose2 :forward
:context di agnose
(synptom ?s type overheat)
(fault ?f type unknown)

-->

((inplication-strength 0.1))
((add-evi dence ?f ?s)))

(defrul e diagnose3 :forward
:context di agnose
(synptom ?s type wont-start)
(fault ?f type battery)

-->

((inplication-strength 0.9))
((add-evi dence ?f ?s)))
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(defrul e di agnose4 :forward
:context di agnose
(synptom ?s type wont-start)
(fault ?f type unknown)

-->
((inmplication-strength 0.1))
((add-evi dence ?f ?s)))

(defrul e diagnose5 :forward
:context di agnose
(synptom ?s type power-1| 0ss)
(fault ?f type lack-of-oil)
-->
((inmplication-strength 0.9))
((add-evi dence ?f ?s)))

(defrul e di agnose6 :forward
:context di agnose
(synptom ?s type power-1| 0ss)
(fault ?f type unknown)

-->
((inmplication-strength 0.1))
((add-evidence ?f ?s)))

;;, any two distinct synptons strengthens the
;;: hypothesis that there's sonething nore serious
;55 going wong

(defrul e diagnose7 :forward
:context di agnose
(synptom ?sl type ?t1)
(synptom ?s2 type ?t2)

(test (not (eq ?tl1 ?t2)))
(fault ?f type unknown)

-->

((add-evidence ?f ?sl1 ?s2)))

;73 here we need the meta-interpreter to assign the

;7 right certainty factors to the remedy objects. Al so
;;; use certainty as a conflict resolution tactic to
;7. print the suggested renedies out in order

(defcontext cure :strategy (priority certainty)
:meta ((uncertain-context)))
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(defrule curel :forward
:context cure
(fault ?f type unknown)
-->
((inmplication-strength 0.1))
(assert (renmedy ? type cross-fingers))
((inplication-strength 0.9))
(assert (remedy ? type go-to-garage)))

(defrule cure2 :forward
:context cure
(fault ?f type lack-of-oil)
-->
(assert (renedy ? type add-oil)))

(defrule cure3d :forward
:context cure
(fault ?f type | ack-of-water)
-->
(assert (remedy ? type add-water)))

(defrule cured4 :forward
:context cure
(fault ?f type battery)
-->
(assert (remedy ? type newbattery)))

(defrule print-cures :forward
:context cure

ipriority 5
(renmedy ?r type ?t)
>

((format t "~%Suggest remedy ~a with certainty-factor
~a" ?t (slot-value ?r ‘c-factor))))

(defun run-di agnose ()
(reset)
(rmake-instance ‘start)
(infer :contexts ‘(diagnose)))

B.4 Other Examples

Other examples distributed with KnowledgeWorks include:
= Truck — a largely forward chaining truck scheduling example,

= Spill — an outline of a chemical spillage diagnosis system, and
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= Whist — a windowing example which plays whist.
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Appendix C

Implementation Notes

C.1 Forward Chainer

C.1.1 Forward Chaining Algorithm

The KnowledgeWorks forward chaining engine is based on the RETE algo-
rithm (see Rete: A Fast Algorithm for the Many Pattern/Many Object Pattern
Match Problem by Forgy in Artificial Intelligence 19, September 1982). A data
flow network representing the conditions of the forward chaining rules (a
RETE network) is maintained and this keeps lists of the instantiations and par-
tial instantiations of rules. This structure is modified at runtime as objects
change. The RETE algorithm relies on the tacit assumption that during the for-
ward chaining cycle relatively few objects change (hence there are relatively
few changes to be made to the network each cycle), and in these cases gives a
huge increase in performance speed.

C.1.2 CLOS and the Forward Chainer

CLOS objects acquire KnowledgeWorks functionality from the STANDARD- KB-
OBJECT mixin. Object creation and modification hooks defined on this mixin
enable the RETE network to track the objects. Objects are indexed into the
RETE network by class and modifications propagated only where any
changes to the slots of the object are relevant.
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One potential problem is that as KnowledgeWorks CLOS obijects are designed
for use in ordinary code, performance could deteriorate seriously as every
time an object is changed the RETE network must be amended. For this reason
changes to CLOS obijects are merely remembered as they are made. The stored
set of changes is flushed at the start of every forward chaining cycle, so the
penalty for using KnowledgeWorks objects is really only paid when the for-
ward chainer is running.

C.1.3 Forward Chaining and the Backward Chainer

For more uniform semantics throughout KnowledgeWorks, the right hand
side of KnowledgeWorks forward chaining rules are executed directly by the
backward chainer, as is the default meta-interpreter for a context which has no
meta-interpreter specially defined. When compiled with debugging turned
off, in many cases the backward chainer can be optimized out leaving raw
Lisp code.

C.2 Backward Chainer

C.2.1 Backward Chaining Algorithm

The KnowledgeWorks backward chaining system is an extended Prolog writ-
ten entirely in Lisp and based loosely on the Warren Abstract Machine
(WAM). (see An Abstract Prolog Instruction Set by David H.D. Warren, Techni-
cal Note 309 SRI International October 1983). High performance is achieved
by compiling each Prolog clause into a Lisp function and handling the Prolog
control flow with continuation passing. This approach removes the need for
interpretation and provides easy integration with CLOS.

C.2.2 Term Structure

In order to provide compatibility with Edinburgh Prolog, the Knowledge-
Works backward chaining system treats Prolog structured terms differently
from lists. Structured terms whose functors are not “.” are stored as simple vec-
tors with the functor as element 0 (for example, the term: f oo( bar) is equiva-
lent to #(f oo bar)).



C.2.3 The Binding Trail

The variable binding trail for the backward chainer is stored in a simple vector
but may overflow into list structure if the trail grows larger than the size of the
vector: (30000). The system will continue to function normally when this hap-
pens but may slow down slightly and do more consing. (Note: We have never
written a program that causes this to happen other than deliberately produced
testing programs).
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Appendix D

For More Information

D.1 General References

D.1.1 Forward Chaining

= Programming Expert Systems in OPS5, An Introduction to Rule-Based Pro-
gramming by Lee Brownston, Robert Farrell, Elaine Kant and Nancy
Martin (Addison-Wesley). Whilst being specifically on OPS5 this text
covers most aspects of forward chaining in considerable detail.

D.1.2 Backward Chaining and Prolog
= The Art of Prolog, by Leon Sterling and Ehud Shapiro (MIT Press).

= The Craft of Prolog, by Richard A. O’Keefe (MIT Press). This is a more
advanced text.

D.1.3 Uncertain Reasoning

= Rule-Based Expert Systems, by B. G. Buchanan and E. H. Shortliffe (Addi-
son-Wesley). This text covers specifically the MYCIN system.
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D.1.4 Expert Systems

Building Expert Systems, by Frederick Hayes-Roth, Donald A. Waterman
and Douglas B. Lenat (Addison-Wesley). This text focuses more on the
issues involved in designing an expert system.

D.1.5 Lisp and CLOS

Common LISPcraft, by Robert Wilensky (Norton). An introductory text
on Lisp.

Common Lisp the Language, Second Edition, by Guy. L. Steele Jr. (Digital
Press). This is the complete reference book on Common Lisp.

Object-Oriented Programming in Common Lisp, by Sonya E. Keene (Addi-
son-Wesley). An introductory text on CLOS for programmers.

The Art of the Metaobject Protocol, by Gregor Kiczales, Jim des Rivieres
and Daniel G. Bobrow (MIT Press). This is the only proper guide to the
CLOS Metaobject Protocol.

D.2 The LispWorks manuals

In addtion to the KnowledgeWorks and Prolog User Guide, the LispWorks man-
ual set includes the following manuals which might be helpful whilst using
KnowledgeWorks:

The LispWorks User Guide describes the language-level features and
tools available in LispWorks.

The LispWorks Reference Manual contains detailed information on the
functions, macros, variables and classes available in LispWorks, in
alphabetical order.

The Common LispWorks User Guide describes Common LispWorks, the
user interface for LispWorks. Common LispWorks is a set of windowing
tools that let you develop and test Common Lisp code more easily and
quickly.

The LispWorks Editor User Guide describes the keyboard commands and
programming interface to the Common LispWorks editor tool.



These books are all available in HTML, PDF and Postscript formats.

= The LispWorks Release Notes and Installation Guide explains how to install
LispWorks, configure it and start it running. It also contains a set of
release notes that documents last minute issues that could not be
included in the main manual set.

This book is available in PDF and Postscript formats.

Commands in the Help menu of any of the Common LispWorks tools
give you direct access to the online documentation in HTML format.
Details of how to use these commands can be found in the Common Lisp-
Works User Guide.

Please let us know if you find any mistakes in the LispWorks documentation,
or if you have any suggestions for improvements.
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Appendix E

Converting Other Systems

E.1 OPS5

OPS5 rulebases may be readily converted into KnowledgeWorks rulebases.
The main OPS5 forms needing conversion are:

e literalize intodef-kb-struct ordef-kb-cl ass. For example
(literalize enpl oyee nanme father-name not her-nane)
could become
(def -kb-struct enpl oyee nane father-nanme not her-nane)

= strategy into a defcontext form with the right conflict resolution strat-
egy. For example

(strategy |ex)

could become

(defcontext ops5 :strategy (lex specificity))
and

(strategy nea)

could become

181



182

(defcontext ops5 :strategy (nea | ex specificity))

In OPS5 you cannot have different conflict resolution strategies for different
sets of rules. The KnowledgeWorks context mechanism for passing control is
much clearer and more powerful than, for instance, the use of the MEA strat-
egy as sole control mechanism in OPS5.

e pintodefrul e. For example, the OPS5 rule

(p recogni ze-pair
(enpl oyee “nane <parent >)
(enpl oyee “nane <chil d> ~not her - nanme <par ent >)
-->
(make pair))

will become

(defrul e recogni ze-pair :forward
(enpl oyee ? nane ?parent)
(enpl oyee ? nane ?child not her-nane ?parent)
-->
(assert (pair ?)))

As an extended example below are given some OPS5 rules from the Monkey
and Banana problem (see Appendix B, “Examples”):

(strategy nea)
(literalize nonkey

nane at on hol ds)
(literalize object

name at wei ght on)
(literalize goa

status type object to)
(literalize start)

(p mbl
(goal ~status active “type holds ”“object <w>)
(obj ect “nanme <w> “at <p> ”“on ceiling)
-->
(rmake goal “status active “type nove “object |adder
to <p>))



(p nb4
{(goal ~status active ~type holds "“object <w>) <goal >}
(obj ect “name <w> “at <p> ”“on ceiling)
(obj ect ~nane | adder “at <p>)
{(nonkey “on | adder “~holds nil) <nonkey>}
-->
(wite (crlf) Gab <w)
(rmodi fy <goal > ~status satisfied)
(rmodi fy <nmonkey> “hol ds <w>))

(p nb8
(goal ~status active "type nove "object <o> "to <p>)
(obj ect “name <o> “weight |ight "at <> <p>)
-->
(rmake goal “status active “type holds “object <o0>))

In KnowledgeWorks this could be:

(defcontext ops5 :strategy (nea | ex specificity))

(def - naned- kb-cl ass nmonkey ()
((at :initformnil)
(on :initformnil)
(holds :initformnil)))

(def - naned- kb-cl ass object ()
((at :initformnil)
(weight :initformnil)
(on :initformnil)))

(def -kb-struct goal status type object to)
(def -kb-struct start)

(defrule nmbl :forward
:context ops5
(goal ? status active type holds object ?w)
(obj ect ? name ?w at ?p on ceiling)
-->
(assert (goal ? status active type nove object | adder
to ?p)))
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(defrule nmb4 :forward

:context ops5

(goal ?g status active type hol ds object ?w)
(obj ect ? name ?w at ?p on ceiling)

(obj ect ? name | adder at ?p)

(rmonkey ?mon | adder holds nil)

-->

((format t "~%ab ~S" ?w))

(assert (goal ?g status satisfied))

(assert (monkey ?m holds ?w)))

(defrule nmb8 : forward

:context ops5

(goal ? status active type nove object ?0 to ?p)
(object ? name ?0 weight |ight at ?q)

(test (not (eq ?q ?p)))

-->

(assert (goal ? status active type holds object ?0)))

E.2 Prolog

Please refer to Appendix A.10, “Edinburgh Syntax”.



Glossary

agenda

A stack of rule groups (or contexts). Control can be passed to the next
context on the agenda.

arity
The number of arguments (to a function, rule condition etc.)

backward chaining

The process of reasoning backward from postulated goals to determine
if their preconditions can be satisfied. If these preconditions are satisfied
the postulated goals are considered true.

browsers

Windows which allow the user to look freely through different parts of
the system.

class

In object-oriented programming, classes define classes with the same
attributes (slots) and behavior (methods). Instances of these classes are
created during the execution of a program which represent concrete
examples of the abstract class descriptions.
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conflict resolution strategy

The method(s) used to decide which of a set of eligible rules will fire. A
conflict resolution strategy is a list of conflict resolution tactics which are
applied in sequence to the conflict set to determine which instantiation is
to fire.

conflict resolution tactic

A single predicate used to decide whether one instantiation is to be pre-
ferred to another. They may be combined into a conflict resolution strat-

egy.
conflict set

The set of instantiations of rules which at a given time are matched by
the object base.

contexts
Groups of rules in a knowledge base.

destructuring

The ability to match an expression against a piece of data where vari-
ables in the expression are bound to the corresponding parts of the data
if the structure of the expression and the data agree. For example, (?x .
?y) can match (1 2 3) with ?x binding to 1 and ?y to (2 3).

forward chaining

The process of reasoning forward from known facts to perform arbitrary
actions and to deduce new facts.

forward chaining cycle

The process of matching the conditions of rules against the object base to
produce a set of rules eligible to fire (the conflict set), selecting one of
those (conflict resolution) and firing it (performing its actions).

inference engine

The part of the system which is responsible for rule-firing, either in back-
ward or forward chaining mode.



inferencing state
A collection of information that the inferencing engine uses.

instantiation

An instantiation of a rule is the set of objects against which a rule
matches. A rule may have no instantiations (if it is not matched at all by
the object base) or many instantiations (each referring to a different set of
objects).

knowledge based systems

A system which encodes the knowledge for a problem domain in high-
level forms, usually facts and rules. The software architecture separates
the knowledge from the inference mechanism used to deduce new
knowledge.

LispWorks

An advanced Common Lisp programming environment, which serves
as the infrastructure for KnowledgeWorks.

meta object protocol (MOP)

Describes how the Common Lisp Object System is implemented in
terms of itself. Hence CLOS may be used to modify its own behavior.

meta rule protocol (MRP)

Allows the user to debug, modify or replace the default behavior of for-
ward chaining rules in the system in terms of backward chaining goals.

object base

The set of CLOS objects which KnowledgeWorks can reason over
(“knows about™).

object-oriented

Programming paradigm in which structures within the language are
organized as classes of objects which have attributes (slots) and behavior
(methods) associated with them.
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objects

The KnowledgeWorks® object base contains KnowledgeWorks CLOS
objects, which may for efficiency be replaced by KnowledgeWorks struc-
tures.

structures

A CLOS class can be replaced by a structure class in cases where speed is
important and the code must be optimized, and when the full power of
CLOS is not required. The structure is then analogous to the CLOS
object.

toolkit

A collection of complementary software or utilities (such as Knowledge-
Works®) with a common application focus.
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